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Introduction 
 
BED 214 – Computer Application in Business is a 2 credit unit course designed to train 
you for the use of personal computer in the world of business.  The knowledge gained in 
this course would lead to proficiency in electronic business management. As a business 
educator in training, it is advised that you study each unit carefully to ensure you gain the 
desired skills required in electronic business management. 

 

 

What you will Learn in this Course 
 
In this course you will be exposed to the business environment, the use of Microsoft 
Word in business, Microsoft Excel in business and other computer applications in 
business. 

 

 

Course Aims 
 
The aims of this course are directed towards preparing: 

 

 

1. citizens  who  would  be  able  to  teach  electronic  business  management at  the 
secondary school levels, and 

2. graduates who would be able to impact the skills of electronic management into 
the general society through workshops, seminars, and in-house training. 

 

 

Course Objectives 
 
At the end of this course, you should be able to: 

 

 

  identify various business documents maximally, 
  create electronic business documents with minimal errors, 
  manage business data effectively, and 
  manage business data efficiently. 

 
Working through this Course 

 
To gain the maximum proficiency required in this course, you must work through all the 
study units.  Starting from module 1, unit 1 to module 4, unit 4.  Ensure you master a unit 
of study before proceeding to the next unit.     Where references are made to previous 
taught courses or elsewhere, you should Endeavour to visit reference sources. 
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Course Materials 
 
This course material consist of : 

 

 

1. A course guide; 
2. The main text, broken down into four modules and 16 study units; 
3. Text books 
4. Microsoft Office 2007 
5. Electronic text 
6. An assignment file 

 

 

Study Units 
 
This course material contains four modules and sixteen study units as follows: 

Module 1 The Business Environment 

Unit 1 Types of Business Organisation 
Unit 2 Problems in General Business 
Unit 3 The Concept of Computer in Business Unit 
4 The importance of Computer in Business 
Unit 5 Caution in the use of Computer in Business 

 
Module 2 Microsoft Word in Business 

 

 

Unit 1 Document Production 
Unit 2 Data Security 
Unit 3 File Management 
Unit 4 Document Presentation, 

 
Module 3 Microsoft Excel in Business 

 

 

Unit 1 Solving and Making Decision with Microsoft Excel 
Unit 2 Managing Large Worksheet 
Unit 3 Presentation of Data with Charts 

 
Module 4 Other Applications in Business 

 
Unit 1 Graphics 
Unit 2 Database 
Unit 3 Microsoft Office Outlook 
Unit 4 Desktop Tools/Data Communication/Creating Website 
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References and Further Readings 
 
Every study unit contain list of references and further readings.  Do not hesitate to consult 
them if need be. 

 

 

The Assignment File 
 

 

The assignment file contains all the Tutor Marked Assignments including BED 214.  Do 
your assignments and you must submit to your tutor for marking.  The marks you obtain 
from these assignments will count in the final score you will obtain in this course. 

 
The Presentation Schedule 

 
The Presentation Schedule included in your course material gives you important dates for 
the completion of Tutor Marked Assignments and tutorial attendance.  Remember, you 
are required to submit all your assignments by the due date.  You should guard against 
falling behind in your work. 

 

 

Assessment 
 
Your assessment will be based on Tutor Marked Assignments (TMAs) and final 
examination which you will write at the end of the course. 

 

 

Tutor Marked Assignment (TMA) 
 
In addition to working through all the TMAs in your course material, four TMAs would 
be sent to you in the assignment file.  The four TMAs must be answered and submitted 
for assessment.   The four assignments would be  marked and the best three would be 
selected which will constitute the 30% of your final grade. 

 

 

Final Examination and Grading 
 
At the end of the course, you will write a final examination which will constitute 70% of 
your final grade.  In the examination which shall last for two hours, you will be requested 
to answer three questions out of at least five. 



4  

Course Marking Scheme 
 

This table shows how the actual course marking is broken down 
 

Assessment Marks 
 

Assignments 
Four assignments, best three marks of the four 
count at 30% of course marks 

Final Examination 70% of overall course marks 
Total 100% of course marks 

 
How to Get the Most from this Course 

 
In distance learning, the study units replace the university lectures.  This is one of the 
great advantages of distance learning; you can read and work through specially designed 
study materials at your own pace, and at a time and place that suits you best.  Think of it 
as reading the lecture instead of listening to the lecturer.    In the  same way a lecturer 
might give you some reading to do, the study units tell you when to read, and which are 
your text materials or set books.  You are provided exercises to do at appropriate points, 
just as a lecturer might give you an in-class exercise. 

 
Each of the study units follows a common format.  The first item is an introduction to the 
subject matter of the unit, and how a particular unit is integrated with the other units and 
the course as a whole.  Next to this is a set of learning objectives.  These objectives let 
you know what you should be able to do by the time you have completed the unit.  These 
learning objectives are meant to guide your study.  The moment a unit is finished, you 
must go back and check whether you have achieved the objectives.  If you make this a 
habit, then you will significantly improve your chances of passing the course.  The main 
body of the unit guides you through the required reading from other sources.  This will 
usually be either from your set books or from a reading section.     The following is  a 
practical strategy for working through this course.  If you run into any trouble, telephone 
your tutor.  Remember that your tutor’s job is to help you.  When you need assistance, do 
not hesitate to call and ask your tutor to provide it. 

 

 

In addition, do the following: 
 

1. Read this Course Guide thoroughly, it is your first assignment. 
 

 

2. Organise a Study Schedule.  Design a “Course Overview” to guide you through 
the Course.  Note the time you are expected to spend on each unit and how the 
assignments  relate  to  the  units.    Important  information,  e.g.  details  of  your 
tutorials, and the date of the first day of the semester is available from the study 
centre.  You need to gather all the information into one place, such as your diary 
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or a wall calendar.  Decide on a method and write in your own dates and schedule 
of work for each unit. 

 

 

3. Once you have created your own study schedule, do everything to stay faithful to 
it.  The major reason students fail is that they get behind with their course work.  If 
you get into difficulty with your schedule, please, let your tutor know before it is 
tool late for help. 

 

 

4. Turn to Unit 1, and read the introduction and the objectives for the unit. 
 

 

5. Assemble the study materials.  You will need your set books and the unit you are 
studying at any point in time. 

 

 

6. Work through the unit.  As you work through it, you will know what sources to 
consult for further information. 

 

 

7. Keep in touch with your study centre as up-to-date course information will be 
continuously available there. 

 

 

8. Well before the relevant due dates (about 4 weeks before due dates), keep in mind 
that you will learn a lot by doing the assignments carefully.     They have  been 
designed to help you meet the objectives of the course and therefore will help you 
pass the examination. Submit all assignments not later than the due date. 

 

 

9. Review the objectives for each study unit to confirm that you have achieved them. 
If you fee unsure about any of the objectives, review the study materials or consult 
your tutor. 

 

 

10. When you are confident that you have achieved a unit’s objectives, you can start 
on the next unit.   Proceed unit by unit through the course and try to pace your 
study so that you keep yourself on schedule. 

 

 

11. When you have submitted an assignment to your tutor for marking, do not wait for 
its return before starting on the next unit.    Keep to your schedule.    When  the 
assignment is returned, pay particular attention to your tutor’s comments, both on 
the tutor-marked assignment form and on the ordinary assignments. 

 

 

12. After completing the last unit, review the course and prepare yourself for the final 
examination.  Check that you have achieved the unit objectives (listed at the 
beginning of each unit) and the course objectives (listed in the Course Guide). 



6  

13. Finally, ensure that you practice on the personal computer as prescribed to gain the 
maximum proficiency required. 

 

 

Tutor and Tutorials 
 
The dates, times and locations of these Tutorials will be made available to you, together 
with the name, telephone number and address of your Tutor.  Each assignment will be 
marked by your tutor.   Pay close attention to the comments your tutor might make on 
your assignments as these will help in your progress.  Make sure that assignments reach 
your tutor on or before the due date. 

 

 

Your tutorials are important; therefore try not to skip any.  It is an opportunity to meet 
your tutor and your fellow students.  It is also an opportunity to get the help of your tutor 
and discuss any difficulties you might encounter when reading. 

 

 

Summary 
 
This course will equip you with the basic skills you require to become competent in 
electronic business management. 

 
I wish you the best of luck as you read through this course. 
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Module 1      The Business Environment 
 
Business is usually associated with buying and selling of goods and services.  To be able 
to sell or buy a good or service requires certain organised procedures. To have a fulfilled 
procedure and a desired attainment of the good or service provided there must be a clear 
and defined data or information, without which the aims and objectives of the business 
might not be achieved. 

 
To have an effective use of the available data and information, there must be a place, 
equipment and personnel to make the data and information meaningful.  It is also 
important to know that data and information vary from organisation to organisation. 
Therefore, in this module you will learn about: 

 

 

Unit 1            Types of Business Organisations 
Unit 2            Problems in General Business 
Unit 3            The Concept of Computer in Business 
Unit 4            The importance of Computer in Business 
Unit 5            Caution in the use of Computer in Business 

 

 

Unit 1           Types of Business Organisation 
 
Contents 

 

 

1.0      Introduction 
2.0      Objectives 
3.0      Main Content 
4.0      Conclusion 
5.0      Summary 
6.0      Tutor Marked Assignment (TMA) 

7.0      References/Further Readings                            

 

1.0      Introduction 
 
Today, computer is inevitable in business transactions.  Before now computer was seen to 
have been meant for certain type of businesses only and in certain types of organisations. 
This belief has been overtaken by the  continuous change in technology, which makes 
every aspect of business to enjoy the benefit of the computer,  whether it is macro or 
micro. 
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Brainstorm: 

 
1.  Take a paper and write out all the names of offices where you 

have seen people using computer. 
 

2.  Are the computers the same in build and model?  What difference 
did you notice? 

 
3.  Identify the duties people perform with computers. 

 
4.  Is there similarity in the duties? 

 
 
 
 
 
 

A good brainstorming would result to your knowing that the offices are not all in the 
same kind of organisation and thereby may not be rendering the same services which in 
turn would lead to performing different tasks with the computer. 

 

 

2.0      Objectives 
 
At the end of this unit you should be able to: 

 

 

  identify the various kind of business organisations, 
  explain certain duties of business organisations. 

 
3.0     Main Content 

 
There are  different  types  of  business  organisations.    They  could  be  manufacturing 
industry, entertainment industry, education industry, health industry, sales and other 
servicing industries.  It is the type of industry or organisation that would determine the 
kind of tasks the computer would be found useful. Let us take few examples: 

 
Education Industry – In this industry the main task facing the manager could be: 
   Compilation of application lists 
   Computation of results 
   Compilation of admission lists 
   Students’ enrolment 
   Projection of students’ enrolment within a specific period 
   Projection of demand and supply of teachers within a specific period 
   Calculation of students’ progression and retention rate 
   Creating question bank 
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   E-learning 
   Production and utilisation of multimedia in teaching and learning 

 
Manufact uring Industry – In the case of the manufacturing industry, the task may be: 

 
   Meeting the demand of customers 
   Ensuring quality control of product 
   Creating an enabling awareness of the product by way of advertisement 
   How to reduce cost without reducing quality 

 
Health Industry – In health industry inclusive hospital and other collaborative bodies 
like pharmacy and the like, there focus is entirely different from the first two discussed 
above.  In this industry they may require computer for: 

 
   Medical information 
   Administrative purposes (this runs across all industry with slight differences) 
   Clinical and special purpose 
   Radiology 

o X-ray 
o Ultrasound 
o Digital imaging technique 
o Bloodless surgery (which can be achieved through simulation) 

   Interactive videoconferencing 
o Teleradiology 
o Telepathology 
o telepsychiatry 

 
In medicine we have what is called telemedicine, which involves  the use of computers, 
the internet and other communication technologies to provide medical care to patients at 
a distance (Burke and Weill 2000). 

 

 

There is no doubt that there is no point of similarity in use.  This is more visible in the 
daily communication like typing of letters, memoranda, sending of e-mails and so on. 
But in the core area of business, the need and use of computers in organisations differ. 
This is why it is very important for business men or those working within an organisation 
to be very conversant with the aims and objectives of their organisations, which is the 
base that  would determine what an organisation would need to do with the computer. 
The  need  and  task  would  therefore determine  the  kind  of  computer  hardware  and 
software that the organisation would need.  Sometimes some certain terminologies may 
sound the same in the use of computers in business but may not actually be requesting 
exactly the same thing.  For example the use of interactive videoconferencing, it is true, 
was first identified with meetings, which make its usage to be acceptable in any field of 
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life.     But  outside  this,  videoconferencing  is  used  differently  in  some  of  these 
organisations, for instance in the medical line a patient’s ailment can be diagnosed and 
surgical operation can be performed at a distance without the patient travelling long 
distance to see the consultant, while education industry may use theirs to simulate 
learning.  In this case, though both organisations might be said to be involved in 
videoconferencing, they would both require different gadgets and possibly different 
softwares in order to be able to have a successful videoconferencing. 

 
Some of these organisations would require special packages to perform the identified 
tasks.   In this regard purpose-made software may be required instead of going for 
commercially produced software.   However, where commercially produced software 
meets the need of the organisation, there would not be need of spending money and time 
developing a new one which usually would take time to complete and. at the same time 
more money would be spent.  Where there is need to provide an in-house package, the 
manager should be able to spell out exactly what the organisation wants to achieve with 
the use of the package.  This would help the programmer to design what can easily be 
used by the concerned persons. 

 
At other times it becomes imperative that specific computerised gadgets have to be 
bought.  Still using the medical line as an example, the normal personal computer with 
just the normal installation of Microsoft windows would not be able to carry out the 
function of x-ray, ultrasound and bloodless surgery.    The nature of  the task therefore 
would determine the right hardware and software that would be used in conjunction with 
the normal computer if need be. 

 
Software products fall into one to the following categories: 

 

 

   Operating systems 
   Utilities 
   Word processors 
   Spreadsheets 
   Database managers 
   Communication and internet browsers 
   Graphics and publishing applications 
   CAD software 
   Multimedia and presentation software 
   Education and entertainment software 
   Software development systems 
   Networking and network-management systems 
   Microsoft Encarta 
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Within these general categories, there are other specialised categories of software, which 
is sometimes referred to as vertical applications. These include: 

 
   Accounting systems 
   Bank management systems 
   Retail point-of-sale systems 
   Financial planning software 
   Legal and medical office management systems 
   Medical diagnostic software 
   Insurance claims processing systems 
   Software development accessories 

 

 

Self Assessment Exercise 
 
Visit hospitals and a banks to find out the different types of problem they solve with 
computers  and  how  they  achieve  their  targets.    Share  your  experience  with  your 
colleagues or facilitator. 

 

 

4.0      Conclusion 
 
In conclusion, as useful as the presence of computers is in organisations, their needs and 
functions should be properly prioritised.   First, the mind set that computers are only 
required for document processing should be discarded because the use of computer in 
business  goes  beyond  processing  of  documents.    Computer  could  be  used  in  the 
packaging of products, for security checks, for product monitoring and so on.  To have 
the best use of computer in your organisation, you need to be conversant with the set 
aims and objectives of the organisation; it is only with this you will be able to actualise 
the use of computer in carrying out your daily task in your office. 

 

 

5.0      Summary 
 
The use of computers in organisations differs from one organisation to the other, 
depending on the nature of business such as education, health and manufacturing.  There 
are times where the functions of computer cut across the organisation but at other times, 
special packages may be required, for instance in the health industry where computerised 
gadgets like x-ray machines are required.  But where commercially produced packages 
meet with the need of the organisation, there may be no need to go for special 
computerised gadgets or  special programmes, so as to reduce cost and avoid waste of 
time. Also, new softwares may be created where customisation of the existing software 
could not serve the desired purpose. 

 

 

6.0      Tutor Marked Assig nment (TMA) 
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Choose a particular industry or organisation and 
 

 

i. List the type of computer gadget and software used in the organisation. 
ii. Explain  the  procedure  the  gadget  and  software  are  used  in  achieving  the 

organisational set goals. 
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Unit 2           Proble ms in General Business 
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1.0      Introduction 
2.0      Objectives 
3.0      Main Content 
4.0      Conclusion 
5.0      Summary 
6.0      Tutor Marked Assignment (TMA) 
7.0      References/Further Readings 

 
 
 

1.0      Introduction 
 
Problems are inseparable from normal human daily activities, hence the need for 
innovation.   It is the  existence of problems that brings about dynamism, because in 
finding a solution to an identified problem, change will occur.  This is to say that problem 
is part of life.  In a more modified form, some people refer to it as challenges, which are 
commonly used in our day-to-day speech. Therefore, just as human beings are faced with 
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challenges so also there are challenges in general business on daily basis. A highly 
challenged organisation can lead to management discomfort until a solution is found. 

 
 
 
 

Brainstorm: 
 

1. Do you have challenges in your life? 
2. How do you solve your challenges? 

 
 
 
 
 
 
 

2.0 Objectives 
 
At the end of this unit, you should be able to: 
  identify basic problems in business, 
  analyse the process of problem solving 

 
 
 
 
 
 
 
3.0 Main Content 

 
The basic challenges that are usually associated with business are: 

 

 

  Having accurate data 
  Processing of data accurately and on time 
  Storage of data 
  Easy retrieval of data 
  Increase in productivity 
  Quality control measure 
  Sustainability in business 

 
Apart from the basic challenges, others could be how to: 

 

 

  manage schedule on a daily or hourly basis, 
  manage list of contact, 
  carry your data with you, 
  be able to work any where, 
  communicate and share data from any where, 
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   work with graphics – intensive or desktop publishing applications, 
   design or use multimedia products, 
   set up complex hardware configurations. 

 
 
 

These challenges could surface in different ways and in different facets.     In  trying to 
solve these problems with the use of computer, the problem may be compounded, reason 
being lack of knowledge of what should have been done.  This may be as a result of using 
right software wrongly.  Therefore, it is important to know where and how computer can 
be use to solve problem. 

 

 

To get a problem solve with the use of the computer, you need to analyse the problem 
thus: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Problem 
Recognition 

Analysis Problem 
statement 

Analysis Solution 

 
 
 
 
 
 

 Data Gathering * Understanding the problem 
 Pre-Processing * Formulating a solution plan 
 Cleansing * Implementing the solution 
 Filtering * Evaluation of the solution 

 

General model of a problem solving process 
Source: Debra Cross/Frank Akaiwa karleen Nordquist/Jessica Evans (2006) 

 
What problem have you identified?    This could come in the form of an obstacle or 
difficulty that could prevent you from reaching the desired goal.  For instance you may be 
faced with a problem of how to delete a row or column in an Excel so as to be able to 
enter more data or to be able to work with the existing data.  The problem could equally 
be that you want to manipulate or sift some data to get information that could enable you 
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take some decisions.   You cannot solve a problem when you do not know the exact 
problem you want to find solution to. 

 
After a problem has been identified, try to identify the cause of it.  This will enable you 
gather the necessary data that would assist you in getting the problem solved.      Pre- 
process, cleanses and filters the data gathered to ensure adequacy.  Having achieved this, 
defined the problem, this definition would give you a clear view of what problem you 
actually want to solve without beating round the bush.  A problem that is not well stated 
or defined could lead to more problems in the sense that working with  the so called 
identified problem may lead to a solution which on the long run may not be found useful 
or may jeopardise business. 

 
After a problem statement has been made, re-analyse the problem by ensuring 
understanding, formulate a solution plan i.e. how you intend to solve the problem, 
implement the solution and finally, evaluate the solution.  The purpose of evaluation is to 
ensure that the solution provided would actually take care of the existing problem.  Once 
evaluation has been certified, a decision can then be taken out of the solution. 

 
 
 

Example 
 
In XYZ company N180 was invested at 12 percent interest compounded quarterly over 
two years given 1.03 compound value interest factor.    Mr.   Adekunle has the duty to 
calculate the amount due at the end of each period for 24 months.  3 months constitute a 
period. 

 
First, Mr. Adekunle needs to identify what is required of him i.e. the problem he needs to 
find solution to.  The major problem would be how to arrive at the value at the end of 24 
months.  Secondly, he needs to analyse the problem, to know what is required.  In this 
instance the periods – beginning principal value and interest value need to be identified. 
These values are required to get the value at the end of each period.     Then think of a 
format to present it for easy calculation and understanding.  This may appear thus in an 
excel worksheet: 



19
 

 
 
 
 

The result would help the company to take decision on the investment made. 
 
 
 

Self Assessment Exercise 
 
Present a problem and state how you would get the problem analysed in the computer 
with the suggestions of possible solutions.  Discuss your result with your colleagues or 
facilitator. 

 

 

4.0      Conclusion 
 
To be able to use the computer effectively in business transaction, you must identify what 
you need the computer for and what aspect/programme/software is required to solve the 
identified problem.  Map out a strategy of how you intend using the identified computer 
software to solve the problem. Then apply the identified software to get the value. 

 

 

5.0      Summary 
 
Every aspect of human life is associated with problems, and business environment is not 
different.   Problem which  is often referred to as challenges come in diverse forms in 
business, which usually affects the adverse decision taken.  Since every negative decision 
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has an effect on the organisation., it is therefore important that appropriate solution is 
provided using adequate processing tools that would minimise errors that could affect the 
final decision.  This requires following a procedure – problem recognition → analysis → 
problem statement → analysis → solution. 

 
6.0      Tutor Marked Assignment (TMA) 

 

 

Visit an office in an organisation (mention the name of the organisation and the office) 
and 

 

 

i.   Identify the office challenges that require the use of computer. 
ii.  Explain how such challenges have been handled in the office. 
iii. State your views about your findings. 
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1.0      Introduction 
 
As discussed in the above unit, human life is associated with challenges and the process 
of looking for ways to solve the challenges leads to discovery.  Before now the major 
machine that was in business was the manual typewriter.  The limitation of the manual 
typewriter led to the invention of electric typewriters which went through several 
processes of modification and advancement.  This was followed by the birth of personal 
computer which today has helped to ease the tasks in business.  This unit will focus on 
the computer. 

 

 

2.0      Objectives 
 
At the end of this unit, you should be able to: 
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   Explain the concept of computer in business 
   Explain the genealogy of the use of computer in business 

 

 

3.0     Main Content 
 
In the 1940s to 1950s, computers were special purpose machines that only large 
institutions such as governments, the military, and universities could afford.  The earliest 
computers were ENIAC (Electronic Numeric Integrator and Calculator) and universal 
Automatic Computer (UNIVAC).  But in 1960, computer revolutionised business world. 
IBM introduced its system/360 mainframe computer in April 1964.  In the 1970s, Digital 
Equipment Corporation (DEC) took further steps to bring computers into mainstream of 
business. 

 

 

Today, personal computer (PC) is the most common computer.    It is PC because it is 
designed to be used by one person at a time.  In spite of its small size, the PC is more 
powerful than any of the room–sized machines of the 1950s or 1960s.  Computers have 
become so vital in the modern society that without them our economy would grind to a 
halt. 

 
The flexibility of the computer makes it very useful in the business world on a daily 
basis.  Office workers use personal computers to write letters, keep employee rosters, 
create budgets, communicate with co-workers, find information, and manage projects and 
so on.  Sales people use computers to manage accounts and make presentations.    You 
now have portable computers called laptop computers or notebook computers. 

 
The operating system (OS) is an important aspect in business, of which an average 
business man should have an idea.   An operating system is a software programme but 
different from other programmes, it is the master’s control programme.  The operating 
system provides the tools (commands) that enable you to interact with the personal 
computer.  It is therefore important we know the OS we use for our business.  Then you 
need to get advise on the central processing unit (CPU) type, Memory, Disk space, 
compatibility is very important when upgrading your personal computer. 

 

 

Early desktop computer users used it as a replacement for the typewriter, to generate 
letters,  memos,  and  other  documents.    Many  business  professionals  relied  on  the 
computer to “crunch numbers”. As time went on personal computer began to replace the 
ledger  book  as  primary  tool  for  tracking  and  analysing  revenues  and  expenses  in 
business.   Individuals and organisation use computers to maintain lists of contracts, 
products, sales, personnel and so on. This leads to what is called productivity software. 
Productivity software is any application that helps the user accomplish a specific task e.g. 
text, graphics,  working with numbers, searching for data or preparing a presentation. 
Examples of productivity software are: 
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  Word  processor   –   provides   tools  for   creating   and   formatting  text-based 
documents. It is the most common software. 

 
  Spreadsheet  programmes  –  used  for  working  with  numbers  and  performing 

complex calculations.  One of the most important tools for accountants, business 
managers, and anyone else who needs to create budgets, analyse statistical or 
collect numerical research. 

 
  Database management system – help to keep track of things from a sales person 

maintaining a list of contracts, to government agencies tracking entire population. 
This  helps  to  gather  large  volumes  of  data  and  process  them  into  useful 
information. 

 

 

  Presentation programme – used for creating sophisticated presentations using text, 
graphics, numerical data, sound and animations.  The resulting presentation can be 
printed, displayed as slides or overheads or played back on a computer screen. 

 
  Desktop publishing (DTP) software – helps to revolutionise the publishing and 

graphic arts industries, allowing the ordinary users the power to produce 
professional quality documents and publications.  The popular DTP software 
packages are Aldus PageMaker, QuarkPress, and Adobe Frame Maker and so on. 

 
Storage device is provided on the personal computer which network administrators, 
CD-ROM drive, Diskette drive or Floppy disk drive Hard disk.  Storage devices can 
be summarised thus: 

 
   Storage device can be classified as magnetic or optical. 

 

 

  The most common magnetic devices are diskettes, hard disks, magnetic tapes, and 
removable hard disks. 

 
  The most common optical devices are CD-ROM, WORM and Magnetic – optical 

disks. 
 

 

To measure derived performance, know the average access time and the data-transfer 
rate. 

 

 

Self Assessment Exercise 
 

 

With reference to a particular organisation, x-ray the genealogy of the use of computer in 
that organisation. Share your answer with your colleagues or facilitator. 
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4.0      Conclusion 
 
Personal computer is designed in such a way that it can serve all business purposes.  The 
type of software installed into the computer, determines the various functions that can be 
performed by it.   Therefore, the type of  business activities in an organisation would 
determine the kind of software that would be required for use in that environment. 

 

 

5.0      Summary 
 
The use of computer in business started in the 1940s as special purpose machines that 
could only be afforded by big organisations like universities, military and government. 
But  with  subsequent  development the  Digital  Equipment Corporation (SEC)  took  a 
further step in the 1970s to bring computer into mainstream businesses.  But today, the 
personal computer is now the most commonly used and more powerful than the room 
size computers of 1950s and 1960s.   The computer has become inseparable from 
economic development because of its role in business. 

 
6.0      Tutor Marked Assignment (TMA) 

 

 

Choose an organisation of your choice and explain the type of computer operating system 
used in the organisation and how it is used to achieve set organisational objectives. 

 
7.0      References/Further Readings 

 
2007 Microsoft Office 

 

 

Allen C. and Klooster (1990).  Computers and Information Processing.  U.S.A. South- 
Western Publishing Co. 

 

 

Bowling Green State University – College of Education and Human Development – 
Busine.  http://www.bgsu.edu/catalog/EDHD/EDHD31.html. Retrieved 13th 
February, 2006 

 
Burke L. and Weill B. (2000).    Information Technology for the Health Professions. 

U.S.A. Upper Saddle River, New Jersey. 
 
Debra   Cross/Frank  Akaiwa   karleen  Nordquist/Jessica   Evans   (2006).      Business 

Computing Using Excel and FrontPage. U.S.A., Thomson Course Technology. 
 
Gross D., Akaiwa F., Nordquist K. and Evans J. (2008).     Business Computing Using 

Excel and FrontPage. U.S.A. Thomson Course Technology. 



25
 

 
 

 

 

Peter Norton (1999).  Introduction to Computers (3rd  Edition). Glencoe McGraw – Hill, 
New York, Woodland Hills, California, Peoria, Illinois. 

Unit 4           The importa nce of Computer in Business 
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1.0      Introduction 
 

 

Much has been said about the computer, but one may wonder why computer has gained 
so much popularity in every aspect of human life.  What is spectacular?  What is unique? 
What is special? These are the curiosity this unit will settle in your mind. 

 

 

2.0      Objectives 
 
At the end of this unit you should be able to: 

 

 

  Explain the importance of computer in business 
  State the shortcoming in the use of computer in business 

 
 
 

3.0     Main Content 
 
On a normal daily business activities computer can be used to track an investment, 
publish newsletter, design a building, practice landing, pay bills by consumers and do 
most shopping on computers.   But outside this, the uses of computer can be classified 
under various activities as follows: 

 

 

1. For  sale  –  helps  to  enter  orders,  write  letters,  track  travel  expenses,  update 
customer files, and create colourful presentations to help sell product. 

 
2.        For Accounting – helps to organise and manipulate large sets of data. 

 
3. Classroom – used for learning process as books, paper, and pens, students use 

computers to develop science projects, prepares reports, gather information from 
electronic sources around the world.    Connection to school networks: Used to 
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guide museum goers and tell them about the exhibits. It is also used to compute 
results and run analysis. 

 
4. With  the  use  of  3D  CAD  tools,  designers  can  create  photorealistic three  – 

dimensional renderings of a finished building’s interior and exterior. 
 

 

5. Using  computer-aided  design  (CAD)  programmes,  architects,  engineers,  and 
designers can perform the entire design process on the computer. 

 
6. Designers use CAD programmes to create products of all kinds.  A designer can 

use a CAD program that creates a three-dimensional wire frame outline of the 
product. 

 

 

7. Factories use computerised robotic arms to do physical work that is hazardous or 
highly repetitive. 

 

 

8. To measure distance:   You can find way anywhere with GPS, which is used to 
determine locations.  GPS receiver can be used on foot, and in cars, boats, and 
planes, GPS units  takes three forms – dashboard units, handheld devices and 
laptop units. 

 

 

9. GPS is used by private pilots and boaters to chart accurate courses and reach their 
destinations safely across unfamiliar routes. 

 
10. GPS is also used by: 

 
a.  Emergency vehicle drivers 
b. Used by geologists to measure changes in the height of mountains and the 

movements of glaciers. 
 

 

11. It is used by police through a Mobile Data Terminal (MDT), which provides speed 
to information, such as license, plate numbers of stolen cars. 

 
12. You can equally make a career from computer such as: 

 

 

a.  Programmer – who helps to develop software to suit a desired house style for a 
particular purpose e.g.  Accounting software. 

b.  A graphic artists, illustrators, designers – use less of keyboard for their jobs, 
but require to draw on  the computer, or even to drag blocks around on the 
screen then may rely more on a pointing device than a keyboard.  CAD and 
high – end design applications frequently can work with digitizing tablets. 

c.  Secretaries, transcriptionists, writers – requires keyboard, scanners to enter text 
from a printed source, speech-recognition software. 
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d. Architects,  engineers,  3–D  designers  –  Requires  large  format  plotters  and 
thermal wax  printers,  though expensive but  indispensable.    3–D  designers 
create elaborate still images of interiors or landscapes; also need high–quality 
colour output for their projects. 

e.  Multimedia and game designers, animators:  For these developers, audio and 
video output is critical.  They need to record, edit, and mix sounds of all types 
as well as play them back.    They also require video recording and playback 
capabilities,  hence the installation of video cards, digital cameras and video 
recording units to their systems. 

 

 

Self Assessment Exercise 
 

With reference to NOUN, share the importance of computer with your colleagues. 
 

 

4.0      Conclusion 
 

 

The importance of computer in business cannot be over emphasised.   As discussed in the 
main content, computer is useful in every aspect of business and to all professions, hence 
the peculiarity and the importance attached to it. 

 

 

5.0      Summary 
 

Computer is very important in every profession which include health, accounting, 
education, architecture, engineering, entertainment, programming, designing and the like. 
The use of computer can be most appreciated when the right software is used by the right 
person, who is able to identify an existing problem and apply the software to solve the 
problem. 

 
 
 
 
 
 

6.0      Tutor Marked Assig nment (TMA) 
 

With reference to an organisation, identify the importance of a computer in business. 
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1.0 Introduction 
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To be able to enjoy the use of computer judiciously without much hitch, certain criteria 
must be considered.  These criteria act as the determining factor in the success you make 
when using computer. 

 

 

2.0      Objectives 
 
At the end of this unit, you should be able to: 

 
   Determine the danger in the use of computer in business 
   Avoid hitches in using computer for business 

 
3.0      Main Content 

 
Are you looking for a way of solving the problem of handling large figures in your 
business accurately? 

 

 

 
 
The computer can do that for you. 
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But to get the maximum relief you desire you must adhere to the following: 
 

 

Buying a Computer 
 
When you want to buy a computer for your business, consider: 

 

 

  The nature of job the computer would be used for, which is what will determine the 
operating system, the memory, and Disk space need to be given a high consideration. 
You may not be a computer expert, but invite the expert who will educate you on the 
right type of computer that will suit the volume of work. 

 

 

Using Computer 
 

 

In using computer you need to be cautious of your health, especially if you work on the 
computer for long hours. 

 
1. Use matching chair and table, sit up straight and ensure that you rest your back on 

the chair back rest to making working on the keyboard free from back ache and 
undue stress.   Do the same even when you are using laptop, especially if you are 
going to work on your laptop for long hours.    Working on the laptop  for long 
hours could affect your health. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Good sitting posture 



31
 

 
 

 
 
 
 

 
 

 
 

Learn to rest your back when you 
type to avoid backache and stress. 
Your health is very important. 

 

 
 
 
 

2. Learn to touch type, i.e. mastering appropriate keyboarding skills.  This will help 
to reduce stress.  Type without looking at the keyboard. Keep your wrists straight. 
Let your hand be in a straight line with your forearms 

 
3. Protect your eyes.  Staring at the computer screen for long hours could strain or 

even injure the eyes.  Many users’ vision has deteriorated as a result of prolonged 
computer use.  What is the way out? 

 
a.  Do not stair at the screen for long hours.  A constant focus at the same distance 

for a long period could distort the shape of your eye lens. 
b. Learn to blink at regular intervals, this would help reduce strain. 
c.  Place your monitor at a distance of between 2 and 2.5 feet away from your 

eyes. 
d. Keep your screen clean and position your monitor in such a way that there will 

not be a direct reflection of light into the eyes. 
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e.  Work on a large monitor screen as least 14 inches, a small monitor may cause 
omission to be too close. 

f. Buy a monitor that holds steady image without flickering. 
 

 

4. Take  regular  breaks. At  intervals,  get  up  and  walk  around,  and  stretch 
occasionally while working. 

 

 

Computer and the Society 
 
The society  is  dynamic,  and  therefore  the  brands  and  models  of  computers  keep 
changing,  hence  frequent  changes  in  available  application  packages  and  operating 
systems.  The changes are usually a total change but modifications to improve daily task. 
There are threats that the computer is faced with: 

 
a. Lack of stable power supply could endanger the life span of the computer, 

hence it is important to support the machine with some gadgets that could help 
maintain or stabilise the current flow into the computer while working.  Power 
surge can destroy your computer fast, so protect your computer. 

b. Another threat could be the upload of package you do not know much about. 
c. Using hardware or software that is not compatible with the system. 

Switch off your computer when not in use.   Though some experts recommend leaving 
computer on all the time, but this practice consumes more amount of energy supply. 

 

 

Computer Crime 
 
Not only is the computer used for business, it is also used by hoodlums to perpetuate 
crime. This in recent times has taken different shapes such as: 

 
  Theft: the value lost in a stolen hardware is usually attributed to the stored data rather 

than the value of the machine. 
  Some people sometimes purposely distribute virus which destroy data fast.  Software 

virus  is  parasitic  programmes  which  can  replicate  themselves. Virus  can  be 
programmed to carry out the following and even more: 

o Copy themselves to other programmes 
o Display information on the screen 
o Destroy data files 
o Erase an entire hard disk 
o Lie dormant for  some time and  become active  after  a  while  when  some 

conditions are met. 
 

To present virus use any antivirus programme like: 
 

 

o Norton Antivirus 
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o Symantec Antivirus for Macintosh 
o McAfee VirusScan 
o IBM AntiVirus 
o Dr. Solomon’s Anti-Virus 
o Virex 
o Disinfectant 
o Avast 

 

 

  Software piracy and illegal copying or use of programme is another crime.  So learn 
to protect your programme before they are lunched into the market. 

  Computer jiggles which are common in cybercafés. Mind whom you do business 
with online. 

  Though the legal system are developing laws to cover the use of computer and it 
peripheries, mind what you do. 

  Piracy is  also  a  threat  between companies  and  their  employees,  especially with 
company owned programmes or software. Protect your trade secret. 

  Some  hackers  constitute  nuisance  with  their  skills  by  stealing  money  or  crash 
computer systems intentionally. Hackers are experts in computer technology, but take 
great  pleasure  in  solving  software  problems  frequently  by  circumventing  the 
established rules and regulations. 

  Passing of junk e-mails and faxes are part of computer crime. 
 

 

Ethical Issues in Computing 
 
In  summary  of  ethical  issue  in  computing,  Debra  Cross/Frank  Akaiwa  karleen 
Nordquist/Jessica Evans (2006). came up with the ten commandments of computer ethics: 

The Ten Commandments of Computer Ethics 

1. Thou shall not use a computer to harm other people. 
 

2. Thou shall not interfere with other people’s computer work. 
 

 

3. Thou shall not snoop around in other people’s computer files. 
 

4. Thou shall not use a computer to steal 
 

 

5. Thou shall not use a computer to bear false witness. 
 

6. Thou shall not copy or use proprietary software for which you have not paid. 
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7. Thou shall not use other people’s computer resources without authorisation or 
proper compensation. 

 
8. Thou shall not appropriate other people’s intellectual output. 

 
9. Thou shall think about the social consequences of the program you are writing 

or the system you are designing. 
 

10. Thou shall always use a  computer in  ways  that ensure consideration and 
respect for your fellow humans. 

 

 
 
 
 

Self Assessment Exercise 
 
Look around the society and state the odds of the use of computer.  Share your view with 
your colleagues. 

 

 

4.0      Conclusion 
 
To receive the maximum usage of computer in business, you need to consider the safety 
of your life because you need good health to run business.  Thereafter, critically examine 
the environment where your business functions  and the threat surrounding the use of 
computer in executing your business in that area.  This will give you knowledge on how 
to protect your business. 

 

 

5.0      Summary 
 
To succeed in every daily activity, caution is taken, which is what is also important in the 
use of computer in business because of the threat the business faces.  The threats in the 
use of computer in business are – health, piracy, theft and wrong use of programmes or 
softwares.  An adequate knowledge of these threats would help to minimise the danger 
that would face the business. 

 
6.0      Tutor Marked Assignment (TMA) 

 
With reference to a particular business, explain the caution required in the use of personal 
computer. 
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Module 2      Microsoft Word in Business 
 
Microsoft Word is a software designed to handle the basic skills of business documents. 
The main features of this software are improvement on the use of the typewriting skills in 
typing basic business documents.  This module will expose you to the management of 
business documents which will acquaint you on: 

 
Unit 1            Document Production 
Unit 2            Data Security 
Unit 3            File Management 
Unit 4            Document Presentation, 

 
All examples in this module shall be based on Microsoft Office Word 2007. 

 

 

Unit 1           Document Producti on 
 

 

Contents 
 
1.0      Introduction 
2.0      Objectives 
3.0      Main Content 

3.1 Letters 
3.2 Memoranda 
3.3 Reports 
3.4 Minutes 
3.5 Invoice 
3.6 Newsletters 
3.7 Flyers 
3.8 Tables 
3.9 Charts 
3.10 Diagrams 

4.0      Conclusion 
5.0      Summary 
6.0      Tutor Marked Assignment (TMA) 
7.0      References/Further Readings 
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1.0      Introduction 
 

 

No business can trive well without data or information which is usually passed from one 
person to another or from one company to another.  The life wire of any company lies in 
the way and manner information is being processed and transferred.   This  makes 
communication imperative in business.  There will be no buying, selling or rendering of 
services if there is no communication. In communication, there must be a sender, process 
and the receiver.   There is no  communication if the receiver cannot decode (interpret) 
what has been sent. 

 
 
 
 
 

 
 
 
 
 

 
 
 

Communication in diverse forms 
 
 
 

All forms of communication are important in business, but this course material would 
concentrate on written communication; which mostly requires the use of personal 
computer.  Written communication in business can take the form of letters, memoranda, 
reports, minutes, invoice, newsletters, flyers, table, charts and diagrams.   These are the 
various forms through which messages can be sent from one source to another.  The way 
these documents are presented speaks about a company’s image.  This is why this unit is 
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designed to teach you the vital skills required when using personal computer for business 
documentation. 

 
 
 
 
2.0      Objectives 

 

 

At the end of this unit, you should be able to: 
 

 

         Identify different types of business documents; 
         Display business document using the appropriate skills. 

 
3.0      Main Content 

 

 

The most commonly used business documents are: 
 
         Letters; 
         Memoranda; 
         Reports; 
         Minutes; 
         Invoice; 
         Newsletters and 
         Flyers. 

 
In the process of producing these documents other functions may be required.      For 
example there might be need to create a table, use charts and diagrams for illustrations. 
In this instance it  becomes necessary to know how personal computer can be used to 
create these documents. 

 
3.1      Letters 

 

 

There are four types of letters. They are: 
 
i. business letters 
ii. circular letters 
iii. personal-business letters 
iv. personal letters 

 
We would start the discussion from the bottom. 

 
Personal Letters – These are letters written or received from relatives and friends.  This 
type of letter can take any form of display.  We are not usually concerned about this type 
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of letter in business.  Personal letters are not regarded as official letters, hence the name 
personal letters. 

 
Personal–business Letters – These are personalised letters that take some features of 
business letters.   The  major difference between personal-business letters and business 
letters is in the salutation and complimentary close.  For a business letter the salutation 
and complimentary close are formal.    For the salutation, it is usually  typed as Dear 
Sir/Dear Madam/Sir/Madam and the complimentary close is “Yours faithfully”.  But for 
personal-business letters, the salutation reflects the addressee’s name e.g. Dear Mr. 
Adegbuyi/Dear Kayode, while the complimentary close ends with “Yours sincerely”. 
Using this form of letter implies that the writer is familiar with the addressee.  The issue 
for discussion or the issue for which messages are sent will be a familiar one. 

 

 

This method is useful at a certain stage in business, because it makes you have a personal 
touch with your clients.  You speak to them in familiar terms; which makes the clients 
feel recognised and happy. 

 
Circular Letters – These are letters addressed to a group of persons.  For example, if a 
company XYZ wants to inform its customers about a change in the company’s closing 
hour; the salutation would read – Dear Customers.  This is to say that the content of the 
letter is for all the company’s customers.  This form of letter is also used by government 
parastatals when instructing the various bodies on actions that should be taken.     This 
form of letter is not specific neither does it consider the interest of an individual. 

 

 

The most important thing to note is that circular letters do not have addressee’s address, 
the salutation is general,  the complimentary close is “Yours sincerely” and sometimes 
omitted, finally the designation is general e.g. Management.  The use of complimentary 
close in circular letters has given way to the non-use of it in Nigeria.  Most companies 
have now adopted the non-use of complimentary close. Rather simply type Management. 

 

 

Business Letters – First and foremost we need to look at the different parts of a business 
letter.    Just as human beings have parts of the body; which is needed for a whole being 
to function, so also are the various parts of a business letter, so as to have a standard and 
presentable business letters. 

 

 

Parts of a Business Letter 
 
The parts of a business letter are: 

 
1.        Writer’s Address 
2.        References – Our Reference and Your Reference 
3.        Date 
4.        Attention Line 
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5.        Addressee’s Address 
6.        Salutation 
7.        Heading 
8.        Body of the Letter 
9.        Complimentary Close 
10.      Signature 
11.      Designation 
12.      Enclosure. 

 

 

Although our concern is on the display of a business letter and not the construction or the 
grammatical structure, the various parts of a business letter would be better understood if 
they are discussed. Therefore, let us look at the discussion of the various parts. 

 

 

Writer’s Address 
 
The first thing to be seen on a business letter is the writer’s address.  There is a need for 
the recipient (the person to whom the letter is written) to know where the letter is coming 
from.  The practice today, is to print the address of the writer at the top edge of the paper. 
Once this is done, it is referred to as letter headed paper. 

 

 

There are different qualities of papers that may be used.  The printer can give a better 
advice on this.  Where there are no printed letter headed papers, the address can be typed 
in thus: 

 
 
 

School of Education 
National Open University of Nigeria 

14/16, Ahmadu Bello Way 
Victoria Island – Lagos 

 
 
 
 
 
 
 
 
To achieve the above you need to consider the following: 

 

 

1.        Set half an inch as top margin 
2.        Set your left and right hand margins at 1 inch each or 11/2 inch each 
3.        Type in the address, break the words appropriately 
4. Highlight each line and select appropriate font type and size to match a letter 

headed paper.  It is not compulsory that all lines of the heading must be equal font 
size. You can vary the size for space or for appropriate display. 

5.        Centre each line vertically on the paper. 



41 

6. You may use colour if desired, but with appropriate combinations to reflect the 
maturity of the company. 

 
You may also decide to use the WordArts. 

Follow this procedure: 

1. Click on Insert, the following display will appear at the menu 
 

 
 
 
 
 
 
 
 

Then click on WordArt -  , the following drop down menu will appear thus: 
 

 

 
 
Click on any design of your choice. 

 

 

2. A dialog box will appear 
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3.        Type in the text in the specified box 
4.        Follow the command to achieve the desired goal. 

 

 

The beauty of the use of wordarts is that you can have variety of display.  Also you can 
move the text as desired by clicking on the text and move to desired position.  But the 
best is to use printed letter headed paper on a quality A4 paper. 

 

 

References 
 
You have two types of references – “Our Reference” and “Your Reference”.  Reference 
helps to establish relationship between the writer and the receiver; which helps to keep 
track of the communication between the two.  “Our Reference” indicates the reference of 
the writer; which is used to keep record of its communication to the receiver.     Then 
“Your Reference” indicates the receiver’s reference; which is also used to keep record of 
its communication to the writer.    For  example if company ABC is writing a letter to 
company XYZ, company ABC reference will be “Our Reference” and company XYZ 
reference will be “Your Reference”.  But if the writing is on its first instance, it would be 
only  ABC  reference  i.e.  “Our  Reference”  that  would  be  available  while  “Your 
Reference” would be vacant. 

 

 

Example 
 
Our Reference: NOUN/REG/CONT/XYZ/1 

 

 

Your Reference:                                              
 
This takes us to how to formulate references. The purpose of  reference as earlier 
mentioned is to track communication.  So in formulating references you need to consider 
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the parameters (tools) involved in tracking the communication.    This may involve the 
names of the company, the department the letter is coming from, the purpose of the letter, 
the volume if necessary and the number.    With the example above, NOUN refers to 
National Open University of Nigeria; REG refers to Registrar which indicates registrar’s 
office; CONT refers to Contractor which implies that the subject matter is on contract for 
company XYZ and the ‘1’ means that is the first letter coming from company ABC to 
company XYZ. Whoever that is writing takes the position of “Our Reference”. 

 
It is often advised that the references positions are printed along side with the letter 
headed paper, e.g. 

 
 
 
 

Show letter headed with reference positions 
 
 
 

Our Ref: Your Ref: 
 
 
 
 
 
 
 
 
Another important thing to note in typing references on a letter headed paper with 
references positions is to ensure alignment i.e. the references should align with “Our Ref” 
and “Your Ref”.  To do this effectively, requires a ruler.  Both the manual and computer 
rulers are found useful. See below to identify the computer ruler. 

 

 

 
 
Sometimes the ruler may not appear as you launch Microsoft Word.  When this happens, 
do the following to make the ruler appear: 
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Click on the view menu –  click on ruler, and the ruler will appear. 
 

 

The computer ruler and the manual ruler have the same measurements.  Use the manual 
ruler to measure the letter headed paper to know the exact measurement where the 
positions of the references are.  Let’s say 2 inches as you measured.  Locate 2 inches on 
the computer and type in the references. As you print, it would align with the headings of 
the references. 

 

 

Date 
 

 
There are two methods of typing dates.    They are the British and American methods. 
With the British method you have the day, month and year for example, 2nd  March 2009 
or 2nd  March, 2009. But the American style would be month, day and year e.g. March 2nd

 

2009.  The British style is the most common and preferred in Nigeria.  The house style of 
either of the two could be adopted. 

 

 

To type the date, leave a minimum of three clear spaces and maximum of five clear 
spaces between the last lines of print on the letter headed paper and the typing line of the 
date. 

 

 

Attention Line 
 
In business letters, there are times the attention of someone else other than the addressee 
is drawn to the subject matter under discussion. In typing the attention line, there are two 
schools of thought – one school says the attention line should be typed before the 
addressee’s address and the other school of thought says that the attention line should be 
typed immediately after the addressee’s address.    The opinion of  the first school of 
thought is that the addressee might not notice the attention line soon after sighting the 
addressee’s address; therefore it should be typed first to avoid oversight.     The  second 
school of thought feels that the addressee being the main person the letter is addressed to 
should have the honour first before the person whose attention is called to the subject 
matter. Again, any method used is acceptable depending on the prevailing house style. 
See the examples below: 

 

 

For the Attention of: Mrs. C. Okoro 
 
The Dean, 
School of Education, 
National Open University of Nigeria, 
14/16, Ahmadu Bello Way, 
Victoria Island, 
Lagos 

 
 
Attention line before the 
addressee’s address 
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OR 
 
The Dean, 
School of Education, 
National Open University of Nigeria, 
14/16, Ahmadu Bello Way, 
Victoria Island, 
Lagos 

 

 

For the Attention of: Mrs. C. Okoro 

 

 
 
 
 
Attention line after the 
addressee’s address 

 
Which ever method that is used; single or double line clear spacing should be left in 
between the attention line and the addressee’s address. 

 

 

Addressee’s Address 
 
This is the address of the recipient. It is typed in single line spacing. 

 

 

Salutation 
 

 

In business letters, the salutation is formal and it is usually typed as Dear Sir/Dear 
Madam.  Where the sex of the addressee is not known, the salutation should be Dear Sir. 
The salutation is typed one or two clear spaces after the addressee’s address. 
Heading 

 
The heading introduces the letter.  It gives an idea to the reader of what the content of the 
letter contains.  The heading is also helpful in sorting of mails.  It is typed one or two 
clear spaces after salutation in capitals and bold.  Preferably font size 14.  Once it is bold, 
it should not be underscored (underlined).  Both underscore and bold perform the same 
function of emphasis; therefore one should be used at a time.     The heading should 
distinctly express the content. 

 

 

Body of the letter 
 

 

This is typed in single line spacing or at the most 11/2  line spacing, with one or two clear 
line spaces in between paragraphs. 

 

 

Complimentary Close 
 
Business letter ends with “Yours faithfully”.  Before now when the use of letter headed 
paper   was  not   common   the   company’s   name  is   typed  immediately  after  the 
complimentary close to show that the writer is writing on behalf of the company. 
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Example 
 

 

Yours faithfully, 
NOUN 

 
These days, this practice is now obsolete, though some companies are still practicing it 
out of ignorance.  Once a company’s letter headed paper is used, it shows that the writer 
is not autonomous rather he/she is standing in for the company.  Should there be a need 
for legal action, it is the company that would be sued and not the individual because the 
individual was not representing himself/herself. Company’s letter headed paper cannot be 
used for personal writing. 

 

 

Signature 
 
A space need to be left for the signature of the writer.  Without the writer’s signature, a 
business letter is disregarded because it is assumed somebody else would have done the 
writing.  But there are occasions whereby someone else needs to sign for the supposed 
writer.  This can be reflected in the designation. 

 

 

Designati on 
 
This is the position the writer is holding in the company.  The designation would signify 
the amount of importance that would be attached to the content of the letter.  Let us look 
at the following examples for clarity: 

 

 

Suppose Mr. O.A. Okonofua is the Sale’s Manager in company ABC, and a letter need to 
be sent from his office to company XYZ to tender apology for the delay in the supply of 
goods to company XYZ,   but it happens that Mr.  O.A. Okonofua is on annual leave. 
Some questions like, would the letter be put on hold until Mr. Okonofua returns from his 
annual leave? Can somebody else write on his behalf? 

 
It is Mr. Okonofua that is on annual leave and not the entire company.   Therefore the 
normal business should still be carried out.  Somebody would have been approved by the 
management of the company to act in his office while he was away for his annual leave. 
So the letter must be written in the office of the Sale’s Manager.  So the complimentary 
close and designation would appear thus, assuming Mr. K.E. Adeleke is the one acting in 
his office. 

 

 

Yours faithfully, 
 
 

Sign. of Mr. Adeleke 
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K.E. Adeleke 
for Sale’s Manager 

 

 

Sometimes it may be that the Sale’s Manager is not on annual leave, but he is very busy 
with official matters.  In this instance he could mandate any of his subordinates to sign on 
his behalf. This would still follow the same procedure as explained above. 

 
It is wrong to type in the name of the manager when he is not the one signing.      The 
signature alone may not be enough to trace the actual person when the need arises.  Using 
the example above, it will appear thus: 

 
Yours faithfully, 
ఌఎ                      K. E. Adeleke’s signature 

O. A. Okonofua 
for Sale’s Manager 
This method must not be used. 

 
Another area of importance in a business letter is when a letter needs to pass through two 
or  more  officers  before  getting  to  the  final  addressee.    For  example  if  a  course 
coordinator or a programme leader is to send an official letter to the vice-chancellor, it 
would be wrong for the  course coordinator or the programme leader to write straight. 
Such a letter must pass through the Dean of the School where the course coordinator or 
programme leader belongs; say School of Arts and Social Sciences. 

The letter will be addressed thus: 

To: The Vice Chancellor, 
National Open University of Nigeria, 
14/16, Ahmadu Bello Way, 
Victoria Island, 
Lagos. 

 
Through:       The Dean, 

School of Arts and Social Sciences, 
National Open University of Nigeria, 
14/16, Ahmadu Bello Way, 
Victoria Island, 
Lagos. 

 
It is not compulsory that the “through” must be typed in full.  The abbreviation “Thru” 
can be used.  The layout pattern has two schools of thought.  One school says that the 
address of the final person to act on the letter should come last while the first address 
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should be the address of the officer that would act on the letter first. Following this 
school of thought, it means the above example would appear as follows; 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Thru: The Dean, 
School of Arts and Social Sciences, 
National Open University of Nigeria, 
14/16, Ahmadu Bello Way, 
Victoria Island, 
Lagos. 

 
To:     The Vice Chancellor, 

National Open University of Nigeria, 
14/16, Ahmadu Bello Way, 
Victoria Island, 
Lagos. 

 

 

Suppose it is more than two addresses, say in a conventional university where a letter is 
routed from a lecturer through the Head of department, through the Dean of the faculty to 
the Vice Chancellor. Such letter will be addressed thus: 

 
Thru: The Head of Department, 

Department of Educational Studies and Management, 
Faculty of Education, 
University of Benin, 
Benin City. 

 
Thru: The Dean, 

Faculty of Education, 
University of Benin, 
Benin City. 

 
To:     The Vice Chancellor, 
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University of Benin, 
Benin City. 

 

 

Remember it could be the vice chancellor first, followed by the Dean and then the Head 
of Department.  The two methods are acceptable depending on the most preferred by an 
individual or the house style of the organization. 

 

 

Where a personal business letter is written, a letter headed paper is not mandatory except 
where the individual has one.  Let us see some samples of business letter. 

 
 
 
 
 

xxxxxx  xxxxxx xxxxx 
xxxxxxxx  xxxxx 

 
xxxx…….. xxxxx………. 

½ an inch 
 
Company’s address 
 
 
Reference line 

 
 
 

Date 

 
Attention Line 

 
 

Addressee’s 
address 

 
 
 

Salutation 
 

 
Heading 

 
 
 
 
 

Body of 
the letter 

 
 
 
 
 

Complimentary 
close 

xxxxxxxx 

xxxxxxxxxxx 

xxxxxxxxxxxx 
xxxxxxxxxxx 
xxxxxxxx 

xxxxxxx 

xxxxxxxxxxxxxxxxxxxxxxxxx 

xxxxxxxxxxxxxxxxxxxxxxxxxxxxxxx 
xxxxxxxxxxxxxxxxxxxxxxxxxxxxxxx 
xxxxxxxxx 
 
xxxxxxxxxxxxxxxxxxxxxxxxxxxxxxx 
xxxxxxxxxxxxxxxxxxxxxxxxxxxxxxx 
xxxxxxxxx 
 
xxxxxxxxxx 

3 – 5 clear line spaces 
 
 
1 – 2 clear line spaces 

 
1 – 2 clear line spaces 
 
 
 
 
 
1 – 2 clear line spaces 
 
1 – 2 clear line spaces 
 
 
1 – 2 clear line spaces 
 
 
 
 
1 – 2 clear line spaces 
 
 
 
 
 
1 – 2 clear line spaces 
 
 

5-6 clear line spaces 
Signature 

 

Signatory 
 

Designation 

xxxxxxxxxxx 
xxxxxxx 
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A simple business letter layout 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
National Open University of Nigeria 

14/16 Ahmadu Bello Way 
Victoria Island – Lagos 

 
The Registrar’s Office 

 
Our Ref::                              Your Ref: 

 

 
5th March, 2009 

 
The Manager, 
MACVY Enterprises, 
14 Jones Street, 
Victoria Island, Lagos. 

 
Dear Sir, 

 
RE:     MR. MARTINS OJO 

 
I write to introduce Mr. Martins Ojo to you.  He is one of 
our Information Technology staff.   He is efficient and 
effective in the use of modern technology.  The university is 
sending  him to train your staff as requested.   Feel free to 
work with him. 

 
We  look  forward  to  receiving  your  comments  on  the 
training. 

 
Yours faithfully, 

 
 
 
 

Abikoye, J. K. 
 

Registrar 
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There are things to note in this letter: 
 

 

1.        The space given after the end of print on the letter headed paper, 
2.        The consistency in the line spacing, 
3.        The signatory, and 
4.        The space provided for signature. 

 
The space given after the end of print on the letter headed paper and the beginning of the 
letter, starting from the “Date” is three clear spaces.  Remember you could also use four 
clear spaces.  The mode of determining these spaces would be explained to you in unit 3 
of this module. 

 
Also the spaces given between each section was consistent.     In typing of letters, use 
single line spacing to type and give one clear space in between paragraphs.  At the most 
use 1½ line spacing and two clear line spaces in between the paragraphs. 

 

 

The signatory is the registrar.  No body is signing for him.  Also enough space is given 
for the signature.  Remember you need to give four or five clear spaces for the signature. 
But supposing someone else is signing for the registrar, the display will go thus: 



 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

National Open University of Nigeria 
14/16 Ahmadu Bello Way 

Victoria Island – Lagos 
 

The Registrar’s Office 
 

Our Ref::                              Your Ref: 
 

 
5th March, 2009 

 
The Manager, 
MACVY Enterprises, 
14 Jones Street, 
Victoria Island, Lagos. 

 
Dear Sir, 

 
RE:     MR. MARTINS OJO 

 
I write to introduce Mr. Martins Ojo to you.  He is one of 
our Information Technology staff.   He is efficient and 
effective in the use of modern technology.  The university is 
sending  him to train your staff as requested.   Feel free to 
work with him. 

 
We  look  forward  to  receiving  your  comments  on  the 
training. 

 
Yours faithfully, 

 
 
 
 

Akintorin T. (Mrs.) 
 

For: Registrar 
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Another important area of note is the style of presentation. The   two   main   styles   of 
business letters presentations are – blocked and indented.    The commonly and widely 
accepted today, is the blocked style as used above.  For the purpose of this course the two 
styles are presented thus: 

 
 
 

 
Blocked Style 
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Long letters usually have continuation sheets.  Plain sheet of the same quality of the letter 
headed paper is used as continuation sheet.  The display of such continuation sheet may 
appear thus: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Continuation Sheet of a Blocked Style 
 
 
 
 
But a letter that is displayed in indented style will appear thus: 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Indented Style 
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In indented style, the first line of typing in each paragraph is indented five or six spaces 
to the right depending on the font size.  This is set as ‘tab’ default.  To achieve this just 
press  the ‘tab’ key and it takes you to the  desired point to start the first line in a 
paragraph.  The complimentary close is typed starting from the middle of the document 
to the right. A continuation sheet of indented style will appear thus: 

 
 
 

 
Indented style continuation sheet 

 
 
 

Note the position of the first line of the addressee’s address, the page number, the date 
and complimentary close. 

 
Self Assessment Exercise 

 

 

Type an invitation letter, inviting an applicant to an interview in a particular organisation. 
Describe the format adopted including the line spacing. 

 
3.2      Memoranda 

 
The memoranda are another form of written communication in a business.    The 
memoranda are used within an organisation.   The singular form is memorandum.  It is 
often abbreviated as ‘memo’.  Memo does not contain addressee’s address, salutation and 
complimentary close, but it must be signed for the purpose of authority; which the 
document needs to carry. How should a memo be displayed? Let us see the following: 
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Most companies also have memo headed paper.  Where this applies, the memo has to be 
printed on the memo headed paper.  There are equally long memo; which may run into 
another page.  The continuation page should not be typed on the memo headed paper but 
on a plain paper. This may appear thus: 

 

 

 
 
 
 

3.3      Reports 
 
Reports are vital in an organisation.  The report of a committee helps in decision making. 
The way reports are typed indicates the type of understanding the readers would receive. 
A good report must reflect the following: 

 
  The body that constitute the committee 
  The date the committee was constituted 
  Members of the committee 
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  The terms of reference 
  Procedure 
  Findings 
  Recommendations 

 

 

These usually form the major headings in a report.  The headings could be presented as a 
shoulder or side headings. The shoulder heading is most recommended. 

 
Reports are typed in single line spacing and at the most, one and half line spacing with 
size 12 in Times New Roman or Arial font type or any other font type within the same 
range.  Where charts and table are required for illustrations, they must be well spaced in 
between lines or paragraphs. 

 
3.4      Minutes 

 

 

Minutes are typed in shoulder or side headings.  Minutes could be presented in a tabular 
form.  This depends on house style.  But whether it is typed in plain or tabular form, the 
most important thing is to ensure that the major headings are well spelt out. 

 
3.5      Invoice 

 

 

Invoices are vital in a business environment.  This may differ from business to business. 
First and foremost, identify the key words that are required to describe the goods to be 
transacted in the business.  Invoice is presented in a combination of straight typing and 
tabulation.  Here is an example of an invoice: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
PLACE LOGO HERE, 

OTHERW ISE DELETE BOX 

INVOICE: 54323 
MONTH DAY YEAR 
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COMPANY NAME HERE 
 

TO: 
COMPANY NAME HERE 
Street Address, Suite 555, City, State 55555 
555.555.5555 
555.555.5555 
555.555.5555 

 
 
 
SHIP TO: 
COMPANY NAME HERE 
Street Address, Suite 555, City, State 55555 
555.555.5555 
555.555.5555 
555.555.5555 

 
 

QUANTITY 
 

DESCRIP TION 
UNIT

PRICE 
TOTAL 

    

  

 
 
 
 

3.6      Newsletters/Flyers 
 

 

Newsletters and flyers are usually display work.   This may require the use of dropped 
caps and column typing.  To insert ‘Drop Cap’.  Type the words and highlight the letter 
that you want drop e.g. .  Then click on ‘Insert’ and click on ‘Drop Cap’, the 
following drop menu will appear: 
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Click as desired and follow the instruction.     If  the  document is  to  be  presented in 
columns, click on ‘Page Layout’ and click on ‘Columns’, it will appear thus: 

 

 

 
 
Select as desired, and follow the instructions. 

 
In selecting new document you can insert default template.  To get this done, click on 
“Office Button” → “New”→ select from the displayed templates → follow given 
instructions in the template. 

 
 
 
 
 
 
 
 
 
 
 
 
 
3.7      Tables 
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To insert a table in a document, click on “Insert” → click “Table”, the following drop 
down menu will appear thus: 

 

 

 
 
Select the rows and columns as desired as you point the cursor through the boxes.  Click 
after you have selected the desired rows and columns.  But where the desired rows and 
columns go beyond the specified rows, click on “Insert Table” and select as desired. 

 
The challenges that are usually encountered in tabular work include: 

  Addition of rows 
  Addition of columns 
  Deletion of rows 
  Deletion of columns 
  Splitting of cells 
  Merging of cells 
  Text Direction 
  Boarder and shading 

 
Now let us see how these can be achieved using the table below: 

 
 
 
 
 
 

  To add row(s) to the above table, do the following:  There are different ways to 
achieve this.  First, place your cursor on the right edge of the last row as shown 
below: 
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and press the enter key.  As soon as the enter key is pressed a third row would 
appear. 

 

 
  
  
  

 
Another way is to highlight, the number of row(s) to be inserted, see example below: 

 
 
With the cursor still in the cell click on “layout” and the following will appear: 

 
 
 
 
 
 
 
 
 
Then click on any of the following in the drop down menu as desired: 

 

 
 
 
 
 
 
 
 
 

From this menu, you can also delete unwanted row and column.  To merge or split cells, 
select as desired from the following section in the menu, while the cursor is placed on the 
required cell(s): 

 
 
 
 
 
 
 
 
 
 

Still on the “Layout” menu, you can align your text within the cell, set your text direction 
and sort data. 
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  There are times you want to add boarder or shading to a cell or some group of 
cells within a table.  To achieve this highlight the cell(s) required and right click, 
the following would appear: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Click on “Table Properties”. The following will appear: 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Click on “Borders and Shading” 
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Then click on “v” shape in the box beside “No Color”, the following drop down menu 
will appear: 

 

 

 
 

 

Choose desired colour, and click OK and OK in the underneath box. The  highlighted 
part will appear thus: 

 
Name Country City 

   
 
You can equally use the “Apply to” in the dialog box to select the desired position within 
the table where you want the colour to appear. 

 
Another method of achieving this is to highlight the cell or cells to be shaded and right 
click, then click on “Border and Shading”, a dialog box will appear, click on “Shading” 
to see exactly the appearance of the dialog box below: 



64  

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Then select colour and apply as desired. 
 
3.8      Charts and Diagrams 

 

 

Charts and diagrams are used for illustrations.    They help to enhance information in a 
business environment.  To insert a chart on a document, click on “Insert” → click on 
“Chart” and the following dialog box will appear: 

 

 

 
 
Select the desired chart. Suppose, a pie is selected, the following will appear: 
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Type in the desired headings 
and figures to over- write the 
default prints, and delete the 
default where not required in 
the excel worksheet 

 

 
 
 
 
 

Once you are done with the data entry close the excel worksheet, then the chart will 
appear.  It can be resized by clicking and dragging.   To edit the chart, right click on the 
chart and click “edit data”. 

 
To insert diagrams, click on “Insert” → picture/Clip Art/Shapes/SmartArt as desired. 
Within the shapes, it is only textbox you can easily type inside the box.  To type text into 
other shapes, right click on the shape and click add text, a cursor will appear.  As soon as 
a cursor appears type what ever you wish to type. 

 

 

Self Assessment Exercise 
 
Get samples of various documents as discussed and practise the typing as described 
above.  Cross check your typing with the above specifications. 

 
4.0      Conclusion 
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Document production is a vital aspect of business communication.  To produce a good 
business document requires adequate practice.   Therefore ensure you practice more of 
this. 

 
5.0      Summary 

 

 

Document  production includes  business  letters, memoranda,  invoice  charts,  and 
diagrams. 

 
6.0      Tutor Marked Assignment (TMA) 

 
Type a report that includes charts, tables and diagrams as illustrations from any source of 
your choice. 
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Unit 2           Data Security 
 
Contents 

 
1.0      Introduction 
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1.0      Introduction 
 
Data security is very important in business.  You need to secure the data or information 
generated or received for the following reasons: 

 
i. for the purpose of future use; 
ii. for easy retrieval; 
iii. for confidentiality; 

 
From time to time information or data are usually referred to for the smooth running of 
any business.  There are time that vital data or information need to be kept for future use. 
In this case the data need to be well secured, failing which there would be a problem at 
the time the data is needed for use.   It is not all information or data that provide their 
usefulness at the immediate; some of them are found useful at a later date.  Therefore 
such data must be well kept so as not to run into problem of need. 

 
It would be meaningless if information or data kept for future use cannot be retrieved at 
the time of need.  This is more frustrating than not having the information or data at the 
first instance. 

 
Finally, for the purpose of confidentiality, information or data need to be well secured. 
This covers both present and future use of data or information. 

 

 

2.0      Objectives 
 
At the end of this unit, you should be able to: 

 
  apply the basic procedure of securing data; 
  explain the basic process of disposing data; 
  explain simple procedure of data storage. 
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3.0      Main Content 
 

 

This content would take you through simple way of securing your documents and how 
such documents could be discarded if not required. 

 

 

3.1     The use of password 
 
The personal computer can be secured without unauthorised persons having access to use 
it.   The use of the  personal computer could be personalised by the use of password. 
Except the right password is typed in, the computer cannot be used.  In this case it means 
the user has to make the password personal.  If not any body that has the password can 
use it.  To personalise the use of a personal computer, seek the advice of a computer 
engineer. 

 

 

Apart from using the password to personalise the use of a personal computer, it could 
also be used to secure access to documents.  In this case, anybody can have access to the 
computer but any anybody cannot have access  to the documents that have password, 
except the person who has the password.   To password a document, use the following 
method: 

 
Stage one:     Type the document 

 

 

Stage two:     Save the document. Do this: 
 

Click on “Office Button” with your document opened. 
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From the dropped down menu 
 

 

 
 
 
 
 
 
 

Click on “Save As”; from the dialog box that will appear select ‘Word Document’ or 
‘Word Template’ or ‘Other Formats’ if you want to save on office 2007, but select ‘Word 
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97-2003’ when you want to save in Word 97-2003 version.  A document saved in Word 
2007 cannot be opened with a lower version of word i.e. Word 97-2003. But if saved in a 
lower version (Word 97-2003), the higher version (Word 2007) can open the document. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
A click on any of the format except ‘Find add-ins for other file formats’ that may require 
other steps, a dialog box will open thus: 

 
 
 

 
 
Now note the following:  

The source name 
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What is unique in these arrows? 
 
The source name – this is the source where you want your document to be saved.  The 
source name in the above dialog box shows “Business Education”  this means that the 
document is saved or is going to be saved under the folder named “Business Education”. 
To select an appropriate source name, click on the small sign like ‘v’ by the side i.e. 

 
 
 
 
 
 
 

Then a dropped down menu will appear thus: 
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Select the desired source.   The volume of what appears at the dropped down menu is 
dependent upon sources that have been created. 

 
Another important aspect of the arrow is the “File name”.  Type in the name in which you 
want the file to be saved, using the example on the dialog box above, the file name is 
“Computer Application in Business” i.e. the name the document is saved with.  A name 
must be given for identification, easy sorting and retrieval.    Do not  use  a name you 
cannot easily retrieve your file with. 

 

 

Then the “Tools”. Click on the black ‘v’ like shape at the bottom: 
 
 
 
 
 
A dialog box will appear thus: 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Click on “General Options”, and a dialog box will appear thus: 
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In the above dialog box, take a look at the directions of the three arrows: 
In the first arrow in the box, type in the name you wish to use as the password e.g. kate. 
You must use a name you can easily remember, if not you may not be able to open your 
document.  Also mind the ‘case’ of letters used i.e. upper case (capital letters - KATE), 
initial case (Kate) or lower case (small letters – kate).  You would notice that though the 
name is the same, the way they are typed is not the same.  It is the way the password is 
recorded at the initial stage that the computer would recognise when opening the 
document. 

 

 

In the second arrow, type in the same password name, it will prompt an error if there is a 
difference. 

 
Click on the small box where the third arrow is pointing to if you want your document to 
be ready only.  What this means is that when the document is opened, you may not be 
able to effect any correction, but can only read.   It is advisable not to click on the box, 
except when you want to make your document read only. 

 
After this process, click on OK, and a dialog box will appear thus: 
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Re-enter the password in the space provided and click OK. The same box may come up 
again, re-enter the same password and click OK.    Then click save at  the  main box 
underneath. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

After this first saving, any other information added to the document would be saved by 
clicking on “save’ from the file menu or press “ctrl + s”. 

 
To open a file that is having a password, a click on the document would produce a dialog 
box where the password would be typed in before it can open. 

 

 
  
  

 
Go through the process once more and ensure you have mastered 
the procedure before you continue to the next stage. 

 

  
 
 
3.2 Data Storage 

 
There are two basic ways to store data – internal and external devices. 

 

 

3.2.1 Internal Device 
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y 

 
 
 

 Type a document and save it through the internal storage system. 
 Save the document in ‘my document’ and back up the document in the local 

disk (C:). 
 

ou happy with your performance? If yes continue, and if not, go thr 

 
 
 
 
 
 
 

u
cess once more before you proceed.

A part of the internal device has been discussed along with the password.      But  it  is 
important to note that documents could be saved in: 

 
i. my document 
ii. my computer – for the internal device under my computer, the saving device 

is the Local Disk (C:) 
iii. Desktop 

 
My document is usually set at the default.  Once ‘save as’ is clicked, the source directory 
that comes up is ‘my document’.  Once saving is done through that source, it means the 
file will be domiciled in ‘my document’.    To  change the source directory from ‘my 
document’ click on the ‘v’ black shape beside the source box as shown in the description 
of ‘password’ and select as desired.  Saving on the Local Disk (C:) means saving on the 
hard disk. 

 
You could save a particular file on both directories i.e. on ‘my document’ and on ‘local 
disk (C:)’,  one would then act as a back up file.  Should there be a problem with one 
directory; the file could then be retrieved from the other directory. 

 
The best source to save your document is “My document”.  Saving in the Local Disk (C) 
is not too secured especially when there is the need to re-format the disk.  The saved file 
may not be recognised.  And saving at the Desktop may slow down the speed of your 
computer. 

 

 

Remember, to save a document, click on file, from the dropped down menu click on 
‘save as’, follow the direction on the dropped down menu. 

 
 
 
 
 
 

      Ar gh the 
pr 

 

 

3.2.2     External Device 
 

Documents could also be stored through the external device through 3½ floppy (A:), 
DVD/CD(D), Pen Drive or Flash Drive and the use of external hard disk. 
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To save on the external device, go through the normal process of saving.      The  major 
difference in the saving is the selected source where the document would be saved. 

Remember  to  click  on  the  ‘v’  shape  black  button   
to select the desired source. 

 
 
 

3.3     Data Disposal 
 
What do you do when you no longer need a particular file or document? 

 

 

 
 
Different questions come to mind: 

 

 

  Am I sure I no longer need this document? 
  Would there be a need of it in the future? 
  Is the document a confidential document? 
  How do I dispose the document? 

 

 

These and many other questions may come to mind. But the most worrisome is when the 
document is a confidential one.  It means it must be disposed without a trace.  A leakage 
in confidential documents could cause the company great distress. 

 
If the file or document is not a confidential document, the normal delete can be used.  In 
this instance it means that the deleted document or file would be resided in the recycle 
bin, which can be culled back if need be.  But where confidential documents or files are 
involved, not only should the document be deleted from the source file name but must 
also be deleted from the recycle bin.   For a very high confidential document, the 
knowledge of an engineer may be sought to ensure proper disposal to avoid any trace that 
may be carried out by experts who may want to retrieve the unwanted data by all means. 

 
When you are disposing the electronic data, do not forget to look at the ‘hard copy’ if 
any.  The hard copy is the printed copy of the document.  Where there is no need for it 
dispose it through the use of trash bin.  Do not burn, do not release for re-cycling and do 
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not give to petty traders to use as wrappers for their wares.  Any of these methods may 
lead to exposing the confidentiality of the document. 

 

 

Self Assessment Exercise 
 
Visit any organisation of your choice, and state the mode of data disposal that is used in 
the organisation. Share your findings with your colleagues and facilitator. 

 

 

4.0      Conclusion 
 
In conclusion, do not hastily dispose your documents or files; ensure you are done with 
them before disposing them off.  Choose the right mode of discarding your files.  Your 
data or information must not litter the environment.  Remember that an information or 
data that is not properly secured could lead the organisation into a doom. 

 

 

5.0      Summary 
 
To secure data or documents or files, the use of password is considered very helpful.  The 
personal computer could use password to personalise the usage.  Where this is not done, 
the file or document could be saved with password, which means the document or file 
can only be opened with the use of the recognised password by the computer. 

 
The user of the computer could choose where a document or file should be saved.  File 
could be saved through the internal device or external device. Both could also be used. 

 

 

But where by a file is no more needed an appropriate means should be used to discard the 
file without allowing the information to litter the environment. 

 

 

6.0      Tutor Marked Assig nment (TMA) 
 
With reference  to  a  particular  organisation,  explain  how  vital  information  can  be 
protected in a business. 
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1.0      Introduction 
 
File management was very pronounced in the office before the advent of the modern 
office.  This was usually referred to as filling system, where filing is done horizontally, 
vertically,  geographically, numerically,  departmentally, alphabetically and by subject. 
But today, most people have lost sight of this various mode of filling systems because 
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they feel it is only associated with manual filling system since the office today speaks 
Information Technology.  This is where the problem lies.    Most users of the personal 
computer find it difficult to manage their files, hence the problem of retrieving files 
especially when the person that created the file is not available.  This unit will teach you 
on how to manage electronic files. 

 

 

2.0      Objectives 
 
At the end of this unit, you should be able to: 

 

 

  Organise electronic files, 
  Organise electronic folders. 

 
3.0      Main Content 

 

 

This unit will teach you how to create file, folder and how to organise them for proper 
office usage. 

 

 
 
 
 

3.1     Creating a File 
 
Remember in the past unit, we have discussed a little on how to create files. As a 
refresher on creation of files, let us consider this case study. 

 

 

Case Study 
 
National Open University of Nigeria has various schools and units divided as follows: 

 
Schools - School of Arts and Social Sciences 

School of Education 
School of Business and Human Resources 
School of Science and Technology 
School of Law 

 
Units - The Vice Chancellor’s Office 

- The Office of The Deputy Vice Chancellor 
(Academics) 

- The Office of The Deputy Vice Chancellor (Administration) 
- The Office of the Registrar 
- Centre for Continuing Education and Work Training 

(CCE & WT) 
- Foundation Programmes (Access and General Studies) 
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- Study Centres 
 

 

These are some of the units that exist in the university. 
 

 

The university is a system where by the various sub units interact to achieve the set goals. 
The major mode of interaction is written communication; which is produced 
electronically.  Also the university may also need to interact with the environment, this 
include the public, other organisation and government.  To have an effective interaction 
also requires the use of computer. 

 
Since the schools and units need each other to contribute to the welfare of the university, 
it means each of them has to keep an up-to-date record of each other interaction to have a 
good link.  But for the purpose of this course material, let us consider the record system 
in the office of the Registrar. 

 
In the office of the Registrar, mail would be sent and received from all the existing 
schools  and  units  as  well  as   the   government  parastatals  and  other   concerned 
organisations. 

 

 

Question 
 
How would the mail be organised electronically for easy retrieval? 

 

 

Procedure 
 

1. For the documents going out of the Registrar’s office, files have to be created 
for them.  A file is for identification. To make the identification much easier, a 
name is attached hence ‘file name’.  The file name is the name given to the file 
for proper identification.   Just as you have name of persons such  as John, 
Modupe, Adewale, Ajadi, Okoli, so as to be able to identify the particular 
person that is being referred to.  So for every document that is created, it has to 
be saved with a file name. You may apply the following process: 

 
a.  Type the document 
b. Click on Office Button 
c.  Click on ‘Save As’ 
d. From the dialog box select the source as desired 

 
Through this method several files would have been created.  The same procedure 
would be adopted in saving a document received.  The only difference would be 
that, you are not the one to create the document rather you have to scan the 
document, import and save with a desired file name.  In this regard, it is assumed 
that the files created in the Registrar’s office may include: 
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  Dr. J. K. Adedeji 
  Prof. O. M. Komolafe 
  Mrs. A. A. Kadiri 
  Dr. J. B. Jubrin 
  Leave Notification 
  Advertisement for Academic Vacancy 
  Workshop on Course Writing 
  Computer supplies 
  Advertisement for Contractors 
  Senate Minutes 
  Students’ Academic Records 

 
In creating a file name, the right name needs to be used for easy sorting.  Therefore the 
name given to a file must be reflective of the content of the document. 

 

 

3.2     Organi sation of Files 
 
Already created files.  This may run into several hundreds, thousands and even more.  So 
if they are not properly organised there will be difficulty locating a file at the point of 
need.  This is where file organisation becomes very vital.  To sort files appropriately, the 
file names must be reflective of the document if not the file may be placed wrongly and 
would lead to difficulty in the process of retrieving same. 

 

 

There are files that need to go together.  Files in the electronic way are documents.  So 
we are now talking about putting related documents together in one box i.e. the folder. 
This could be likened to the normal manual flat file folder or arch file where documents 
of related matters are kept. 

 

 
 
 

Folder Arch file 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Documents 
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The list  of  files  above  from the  registrar’s  office has  to  be  sorted  so  that  related 
documents have to be kept in the same folder for easy identification. 

 

 
 
 
 

3.3 Creating a Folder 
 
How do I create a folder? To create a folder, do the following: 

 

 

i. Open the source where you want to save the document e.g. ‘My Documents’.   To 
get to my documents click on start and from the dropped down menu, click on my 
documents. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Another method is to click on My Documents on the Desk top if it is available there. 
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ii. Click on my documents and a dropped down menu will appear thus: 
 
 
 

 
 
 
 

showing all the files and folders that have been saved so far. 
 

 

iii. right click on the free white space and another dropped down menu will come up. 
 
 
 
 
 
 
 
 
 
 
 
 

Free white space 
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A dialog box shows when you right click 
on the white space 

 
 
 
 
 

iv. click on New, and another dialog box will appear thus: 
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v. click on folder, and the following box will appear: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
This box appears. Type in the name you want to 
use to save the folder.  You can do this in two 
ways – type on top of the name (New Folder) in 
the box to over write or use back spacer key or 
delete key to delete the name (New Folder) and 
type in the desired folder name. 

 
 
 
 
Note: Follow this procedure to create as many folders as desired.  Working with the files 
from the registrar’s office as indicated above, all the files are not related.  To make files 
more manageable, we have to sort into schools and units.    So in this instance folders 
should be opened for the various schools and units. 
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 Self Assessment Exercise 

 
Open folders for all the schools and units in National Open 
University of Nigeria as stated above. 

 

  
 
 
 

vi.       Enter files into folder. There are two ways of entering files into folder. 
 

First, if the files have been created, open the source where the files are and open 
the folder.   Copy the  file(s) and paste inside the folder using the cut and paste 
mode.  Sometimes both the folder and the file(s) may be in the same source like 
my document. E.g. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The folders are in yellow colour.  The others are files.  Let us assume we want to put the 
files into the folder named ‘New Folder”.  Right click on the file, a dropped down menu 
will come up, from the dropped down menu click on ‘copy’ then go to the folder  (New 
Folder) where you want to copy the file, double click (i.e. fast click twice) and the folder 
will open thus: 
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This shows there is no file in the folder.  Right click inside the white space and from the 
dropped down menu, click on paste.   Let assumed the file we copy is ‘Business 
Management – LASU’, as you click on paste the file will appear on the folder thus: 

 

 

 
 
 
 

You can enter as many files in this order.  But you must ensure that the files entered are 
related to the name given to the folder, because the folder is acting as the umbrella. 
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Apart from copying the files one by one you could highlight all the files you want to 
copy, right click and click on copy and go to the folder, right click and click on paste, all 
the files copied would be pasted at once. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Highlighted files 
 
 
 

You could also use drag and drop method.  With this method, left click on the file, hold 
down the mouse without releasing your finger and take the cursor to the folder and 
release your finger.  As soon as this is done, the file(s) automatically copy into the folder. 

 
The best method is: 

 
  to create a folder first 
  then type the document 
  click on file 
  click on save as 
  click on the source where you want the document saved e.g. my documents 
  click on the folder you have created 
  and save 
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 Self Assessment Exercise 

 
Try each of these methods. Go through them several times until 
you ascertain proper mastery. 

 

  
 

 
 

3.4 Organi sation of Folders 
 
Remember you have created folders for all the schools and units in National Open 
University of Nigeria.  If the folders are left to exist the way they are, they will turn to 
junks i.e. it will again become unmanageable.  Therefore there is a need to arrange these 
folders.   Take for example, the folder named ‘school of education’ in  the Registrar’s 
office.  There are so many letters going and coming from School of Education.  Putting 
everything together will not make it manageable, so there is a need to create other folders 
within the folder ‘school of education’. 

 
But before creating folders within the school of education, yearly folders e.g. 2002 folder, 
2003 folder, 2004 folder etc need to be created and within each year folder two major 
folders need to be created in office of the Registrar.  These folders are ‘Incoming Mail 
folder’ and ‘Outgoing Mail Folder’.  Folders for all the schools and units in the university 
would be present in both the incoming mail folder and the out going mail folder.  This is 
for easy retrieval.  The incoming mails should be recorded electronically both the ones 
that are received in electronic form and those that are received in hardcopy form.  The 
hard copy form would be made possible through scanning. 

 

 

Within each school or unit folder, other folders can now be created e.g. staff record, 
facilitators update, Notice of Senate meeting etc. 

 
To save folder inside another folder, follow the same procedure of saving file(s) inside 
folder. 

 
 
 

  
 Self Assessment Exercise 

 
Try your hands on this and share your experience with you 
colleagues 
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4.0      Conclusion 
 
To be effective and efficient in an organisation, documents must be properly managed 
failing which the efficiency level will be very low.  Low efficiency could increase the 
problem of quality assurance which is sought by the public.  Therefore the issue of file 
management must be considered very vital in the business world. 

 

 

5.0      Summary 
 
To have  adequate file  management, create  files with file  names  that can  easily be 
retrieved and arranged them in manageable folders for easy retrieval and control. 

 

 

6.0      Tutor Marked Assig nment (TMA) 
 
With reference to a particular organisation, explain the process of managing a file in a 
business. 
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1.0 Introduction 
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The way documents are presented speaks about the integrity of an organisation.      A 
document may carry good information, but if the document has poor presentation, such 
document would send wrong signals in spite of the good information it possesses. This is 
why document presentation is very important in business.  This unit would therefore be 
devoted to discussing different areas that are eye catching in document presentation. 

 

 

2.0      Objectives 
 

 

At the end of this unit, you should be able to: 
 

  Format documents 
  Review documents 

 
3.0      Main Content 

 
3.1  Formatting 

 

 

There are different types of formatting: 
 

 

  Simple Character Formatting e.g. underline, bold, italicize your 
text. 

 
To achieve this, click on Home on the menu bar and click the desired 
formatting - 

 
 
 
 

. 
 

Short cut keys could also be used. Press ctrl + B for bold, ctrl + I for 
italic and ctrl + U for underscore. Press one of the shortcuts before 
you type the text you want to format. When you want to stop 
formatting, press the same shortcut key to turn off  the formatting. 
You can also format already typed document.    To  format  already 
typed document, highlight the desired part and select the desired 
format. 

 
 
 

  Special character formatting.  These are used to enrich the document. This may be 
“Page Background”, which may include watermark, page colour and page borders. 
You may also want to effect “Page Setup” or work in different “Paragraphs”.  To 
achieve any of these, click on “Page Layout” in the menu and select as desired. 
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To have special effect on font like subscript and superscript, click on “Home” in 
the menu and select from: 

 

 

 
 

for example to type 9 to the power of 3,  type 9 and 3 thus 93, highlight 3 thus 
and click 

 
 
 
 
 

then it will appear thus 93. 
 

To achieve paragraph formatting, click on “Page Layout” and select the desire format 
under “paragraph”. 

 
3.2  Proofreading 

 

 

It is important to proofread a typed job before it is sent out of the organisation.  This is 
best achieved by the use of Thesaurus, spelling and grammar tools.  To get this click on 
“Review” and select as desired.  A quick type can be done by highlighting the desired 
word(s) and right click on the word to check for spellings and grammar.  Sometimes, the 
computers automatically prompt green or red waiving lines.    The green waiving line 
queries grammar, while the red waiving line queries spellings.  These serve as alert to 
proofreading. 

 

 

Another important aspect of proofreading is the use of “Track Changes”.     This  will 
enable you to edit materials electronically. 
Self Assessment Exercise 

 
Edit a material electronically, and share your experience with your colleagues. 

 

 

3.3      Mail Merging 
 
Mail merging is very important in the production of business documents. There are times 
there is the need to send the same content of a document to several persons probably with 
different names and addresses.  In this instance, mail merging is the best option that can 
be used to achieve such documentation within a short time. 

 

 

To mail merge, the following steps may be taken: 
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First, prepare a table for the information that would be different in the document e.g. 
name and address. This may appear thus: 

 

 

Name Address 
 

John Mark 
12 Street
Benin City 

 

Ojo Adekunle 
23 Abiola Avenue
Lagos 

 

Okoro Nduka 
School of Education
NOUN, Lagos 

 
Pius Ehimen 

Department of Arts and Social Sciences 
Lagos State University 
Ojo 

 

Caroline Ujagbe 
56 Lane Close
Kano 

 
Dada Ojugo 

Plot 547
Arewa Suit 
Abuja 

 

Ibhagbosoria Uduaghe 
99 Ajuwa Avenue
Sokoto 

 
Save the table in appropriate source. 

Secondly, type the document, say a letter e.g. 

 

 

Dear 
 

 

We are glad to inform you that our interest rate has been reviewed downwards.  You are 
now to pay 2.5% on  any outstanding loan as from the month of September, 2009 as 
against the 6% earlier charged. 

 
Should you need further clarification, please feel free to ask. 

Yours Sincerely, 

 
 
 

This letter is to be sent to different persons and addresses.  So let us identify where the 
names and addresses would be inserted. 

 
 
 

“Address” 
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Dear “Name” 
 

 

We are glad to inform you that our interest rate has been reviewed downwards.  You are 
now to pay 2.5% on  any outstanding loan as from the month of September, 2009 as 
against the 6% earlier charged. 

 
Should you need further clarification, please feel free to ask. 

Yours Sincerely, 

Thirdly, place the cursor on the document and click on “Mailings” at the menu bar.  Then 
click Mail Merge → Step by step mail merge wizard, then a drop down menu will appear 
thus at the right hand side of the screen: 

 

 

 
 
At the bottom of the drop down menu click on “Next: Starting document”, and follow the 
instructions. 

 

 

When you click on step 3 a dialog box will appear requesting for your existing list. Click 
on the source to open the file. With our above list, this will appear: 
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Then click OK.  A click on step 4 will bring the following dialog box 

 

 

 
 
Place your cursor on the first place of insertion, in this instance where you want the 
address to be placed then click on “More items”, the following dialog box will appear: 
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Click Insert. Repeat this in all the points of insertion. A click on step 5 will effect all the 
identified names and addresses. 

 
To enhance the mail, you may work through the icons on “Mailings” 

 

 

 
 
 
 

Self Assessment Exercise 
 
With the use of mail merge, type a letter and duplicate same to 10 persons. 

 
4 Conclusion 

 

 

It is good to present our documents in a way to enhance understanding and as well as 
gaining time. 

 
5 Summary 

 
In presenting a business document, attention should be given to appropriate formatting as 
well as time gaining techniques, such as mail merging. 

 
6 Tutor Marked Assignment (TMA) 

 

 

Edit any material of your choice with the use of “Track Changes”.  Use balloon to show 
the changes in the text and print. 
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Module 3      Microsoft Excel in Business 
 
Microsoft Excel is very useful in the business world, especially in the computation of 
data that involve figures and complicated tabulations.   This module would discuss the 
day-to-day activities that require the use of excel in business.    BED 211 – Microsoft 
Office has already introduced us to Microsoft Office Excel, therefore, this module would 
focus on the use of excel for problem solving in  business.  Microsoft Office Excel 2007 
would be used in this module to discuss the following: 

 
Unit 1            Solving and Making Decision with Microsoft Excel 
Unit 2            Managing Large Worksheet 
Unit 3            Presentation of Data with Charts 

 

 

Unit 1           Solving and Making Decision with Microsoft Excel 
 
Contents 

 

 

1.0      Introduction 
2.0      Objectives 
3.0      Main Content 

3.1 Identification of Business Problems 
3.2 Problem Analysis 
3.3 Identification of Possible Solution 

4.0      Conclusion 
5.0      Summary 
6.0      Tutor Marked Assignment (TMA) 
7.0      References/Further Readings 

 
1.0      Introduction 
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In Microsoft Word, we study some tabular work which involves the use of columns, 
rows, and cells.  But there is a limit to which Microsoft word can handle tabular work, 
especially when advanced calculations are involved.    This  is  where  Microsoft Excel 
comes in.  This unit will expose you to the beginning part of the use of Microsoft Excel. 

 
2.0      Objectives 

 

 

At the end of this unit, you should be able to: 
 

 

  Solve basic problems in business by applying basic statistics with the use of Excel. 
  Analyse basic problems with the use of Microsoft excel. 

 
3.0 Main Content 

 

 

3.1      Identification of Business Problems 
 

Excel works with columns, rows and cells.  Sometimes problem may occur in the use of 
formulas, using formulas and cell references instead of values and determining order of 
preferences. Let us look at some areas that may require problem identification: 

 

 

Excel Arithmetical Operations – 
 

 

Calculation Excel Operations Example 
Addition + =3+A1 
Subtraction - =A1-A2 
Multiplication * =A1*4 
Division / =X4/Y4 
Exponent ^ =2^8 

 
You will recall that in BED 211 – Microsoft Office, we were told that every formula in 
excel starts with ‘=’ sign.  By way of interpretation, under the column of example above, 
the equal sign is mandatory.  =3+A1 means the value 3 is added to any value that is in 
cell A1.   In the second row, =A1-A2, it means the value in A2 is subtracted from the 
value in A1.  In the third row, =A1*4 means the value in A1 is multiplied by the value 4. 
The fourth row =X4/Y4 means the value in X4 is divided by the value in Y4 and finally 
in the fifth row =2^8, it means the value 2 is raised to the power of 8.  The day-to-day 
activities in the business world require these basic arithmetical operations for business to 
flow.  For example, a business man may want to get the total amount of sales per month 
and year.  In this case, it means monthly sales should reflect as well as the summation per 
year.  Also the business man may want to get the net profit, by subtracting all expenses 
from the gross profit made.  This can be achieved by simply entering the right formula to 
capture the right value. 
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Order of 
Precedence 

Example Resulting
Value 

Explanation 

1. Operations in 
parentheses 

=A1*(3+5) If A1=2, the
resulting 
value is 
2*(3+5), or 
2*8 = 16 

Excel first performs the 
addition of 3 + 5 even
though  multiplication
has a higher precedence
than addition, because
the addition operation is
enclosed in parentheses 

2. Exponentiation =3*A1^3 If A1 = 2, the
resulting 
value is 
3*2^3 or 3x8 
= 24 

Excel first performs the 
exponential operation of 
cubing A1, and then 
performs the 
multiplication 

3. Multiplication 
and division 
from  left  to 
right 

=A1 +  B2*
C3 

If A1=2, B=3
and C3 = 10,
the resulting
value           is 
2+3*10       or 
2+30 = 32 

Excel first multiples B2 
by C3,  and  then  adds 
the result to A1 

4. Addition and 
subtraction 
from left to 
right 

=A1- 
B2+C3/10 

If        A1=2,
B2=3, and 
C3=10, the 
resulting 
value is 2-3+1
or -1+1=0 

Excel first divides  C3 
by 10, then subtracts B2
from  A1,   and   finally
adds this value to the
quotient 

 

Formulae and Cell References instead of values - 
 

 

Supposing the cost of producing 1000 copies of a textbook is N3,235, the cost of one 
textbook will be N3,235 divided by 1000.  Using excel formula it will be N3,235/1000. 
It is wrong to type a value into a cell instead of entering the formula that produced the 
value.  Typing a value will make your work cumbersome and you will find it difficult to 
reference cells.  To work with formulae accurately and with fewer problems you need to 
know how to determine order of precedence rules. 

 
Order of Precedence Rules 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

excel to solve the problem. Discuss your experience with your colleagues. 
 
 
 

 
3.2 Problem Analysis 

 

 

S 
ource: 
Gross, 

Akaiwa, 
Nordqui 
st & 
Evans 
 
 
 
 

Self 
Assessm 

ent 
Exercise 
 

Identify 
problem 

areas  in 
a 

business 
known 

to you 
and 

express 
how you 

would 
use 
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The following is a case study: 
 

 

Sharback manufactures and sells Adire (tie and dye) clothes at Abeokuta, a town which is 
distinctly known for  good Adire clothes.   Due  to  the  popularity of  this  Adire,  the 
company is challenged to meet the demand.   The manufacturing company is forced to 
add volume  to the quantity manufactured so as to be able to meet with the demand. 
Sharback is committed to maintaining a high standard for which the company is known, 
but there is a great concern that the standard may be  compromised due to increase in 
production.  One of the problems in the production process is Quality Control, which is 
often referred to as “QC”.  Each Adire is thoroughly inspected and tested before being 
released for sale when a defect is detected.  The defect is traced to the original production 
line that manufactures and package the Adire.    Adewale who is the control manager 
noticed an increase in defect products since the increase in the production of Adire.  The 
fear arose that the company may not be able to meet the demand if the numbers of 
defected goods keep increasing. 

 

 

In this instance, Adewale would need statistics for the analysis statistics for thorough 
analysis.. 

 
Using Statistical Functions of Data Values 

 
The skills required in using statistical functions include: 

 

 

  Freezing rows and columns 
  Splitting a window into panes 
  Using absolute references 
  Using the AVERAGE function 
  Using relative references 
  Using the ROUND function 

 
Statistics is often referred to as a subset of mathematics, which is applied to observe data. 
Some common statistics that are used are: 

 
  Mean 
  Median 
  Mode 
  Standard deviation 

 

 

The mean is the arithmetical average of a set of data.  Median is the arithmetical value 
that occurs in the middle of a set of data.  Mode is the arithmetic value that occurs most 
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frequently in a set of data.  Standard deviation is a measure of how widely data values are 
dispersed from the arithmetical mean. Let us see the following examples: 

 
Values: 8, 7, 2, 2, & 10 

 
a.  Arithmetic mean =  (8+7+2+2+10)/5 
b. Median = to get the median, reorder the value in ascending order thus: 2, 2, 7, 

8, 10, the middle value 7 is the median. 
c.  The mode is the value that occurs most often, in this set of data, the mode is 2. 
d. The standard deviation is the degree which scores spread out about the mean or 

central tendency. 
 
The mean in two sets of data might be the same but with different standard deviation, 
which shows the data is more or less widely distributed or could exhibit entirely different 
distribution profile.  Also two data might have the same standard deviation and the mean 
values in the same data could be different, this indicates two dissimilar manners. 

 

 

In the case of Sharback Adire production, Adewale must analyse the recent trend in Adire 
being rejected in the quantity control for quality defects.  The two most common defects 
being found in the Sharback Adire models are as follows: 

 
  High colour coefficient indicating poor surface finishing that can result in fast 

fading of material.  Adires are rejected if the colour mixture differ from the actual 
colour number with   0.01 

  Low texture strength indicating that the material texture cannot absolve the desired 
colour.  The Adires are rejected if the texture of material is less than 0.7 

 

 

The problem has under gone some analysis, the next stage would be to identify possible 
solution. 

 
3.3      Identification of Possible Solution 

 

 

To be able to identify the possible solution that excel can provide the following are 
essential: 

 

 

In  statistical  value,  you  may want  to  ROUND  functions e.g.  26.436  would  be  26. 
Examples of ROUND functions are: 

 

 

Formula Description Resulting Value 
=ROUND (26.436) Rounds 26.436 to the

nearest whole number 
26 

=ROUND (B2,1) Where B2 contains 21 
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Function 
 

Description Syntax and Example 
Resulting 
Value 

 
 
 

ROUND 

Rounds a 
number to a 
specified 
number of 
decimal places 

ROUND (number, num- 
digits) = 
ROUND(25.33%,2) 

 
 

25% 

 
 
 

ROUND-UP 

Rounds a 
number up to 
the specified 
number of 
decimal places 

ROUND(number, num- 
digits) = 
ROUNDUP(1.002,2) 

 
 

1.01 

 
 
ROUND 
DOWN 

Rounds a 
number down 
to the specified 
number of 
places 

ROUNDDOWN 
(number, num-digits) = 
ROUNDDOWN(9.99,0)

 
 

9 

 
 
 

EVEN 

Rounds a 
number up to 
the next 
highest even 
integer 

 
EVEN (Number) = 
EVEN(2.23) 

 
 

4 

 

 value 21.38, round
21.38 to   the nearest 
tenth 

 

=ROUND (102234,-2) Rounds 102234 to the
nearest hundred 

102,200 

=ROUND (33.75%,2) Rounds 33.75% to the
nearest hundredth, 
which  is  the  same  as 
the nearest percent 
because the precise 
value is 3375 

 
 
 

24% 

=ROUND 
(SUM(10.33,10.44),0 

First  sum  20.33 and
20.44     resulting     in 
40.77, then round the 
value to the nearest 
whole number 

 
 

41 

 
These functions can also be expressed in excel. Let us see the following: 

Examples of Functions that modify the precision of a value 
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ODD 

Rounds a 
number up to 
the next 
highest odd 
integer 

 
ODD (number) = 
ODD(1.23) 

 
 

3 

 
 
INT 

Round a 
number down 
to the nearest 
integer 

INT (number) 
= INT(-4.3) 

 
-5 

 

 
 
 

TRUNC 

Truncates a 
number to an 
integer 
removing the 
fractional part 
of the number 

 
TRUNC (Number, 
num-digits) 
= TRUNC(-4.3) 

 
 
 

-4 

 
 
 

Paste Special 
 

 

The copy and paste mode is the same in what we have learned in BED 111 (Introduction 
to Keyboarding and Word Processing), BED 112 ( Advanced Word Processing) and BED 
211 (Microsoft Office).  But there are situations where you need to use the paste special 
mode. When you click on paste special; click on the desired function. As a reminder, let 
us look at the following Paste Special box: 

 

 
 

Let us see the explanations of some of these paste functions in the table below: 
 

 

Formulas Description 
 

Paste Special Displays a dialog box that provides 
different paste options 

 

Formulae 
Paste only the formulae from the 
original (copied) cells 
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Values 

Paste only the values from the 
original cell(s); the formula or any 
formatting are not pasted 

 
All except Borders 

Paste the formulae and formatting 
from the original cell(s), but not the 
format of the cell borders 

 
 
 

Transpose 

Paste the formulae and formatting 
from the original range of cells, but 
reverses the orientations, so that the 
rows of the original cell range, and 
the original columns become rows 

 
Paste Link 

Paste a connection or link to the 
original cells, including the applied 
formatting 

Paste operations (Add, Subtract, 
Multiply and Divide) 

Paste the operation so specified 

 
 
 

Mean, Median, Mode and Standard Deviation 
 

 

Excel Statistical Functions 
 

Statistic Function and Syntax 
Arithmetic Mean AVERAGE(number 1, number2,…) 
Median MEDIAN(number1, number2, …) 
Mode MODE(number1, number2,… 
Standard Deviation  

 
 
 

Now let us calculate the statistics for the colour coefficient 
 
 
 
 
 
 

 
Quantity Control Data for Sharback Ventures 
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  Unique manufacturing identification number (mfg ID#) 
  Size 
  Style 
  Date manufactured 
  Production line on which the Adire was manufactured 
  Colour coefficient value 
  Low texture 

 
To calculate the colour coefficient, the mean, median, mode and standard deviation are 
calculated for proper decision making.   To achieve this, the following formulas are 
entered: 

 
For Mean - =AVERAGE(F2:F5) 
For Median - =MEDIAN(F2:F5) 
For MODE - =MODE(F2:F5) 
For STDEV  -          =STDEV(F2:F5) 

 
The result showed there was no mode. The standard deviation would be best used for the 
decision.  The present standard deviation would be compared with the previous standard 
deviation. The lower the standard deviation the better the coefficient. 

 

 

The use of excel in problem solving is not limited to manufacturing industry.  It could be 
applicable  to  other  industries such  as  education.   Let’s  see  how  we  can  solve  the 
following problem: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
S/NO 

 

 
NAMES 

 
MAT RIC 
NUMBER 

 
C.A.

EXAM 
SCORE

 
TOTAL 

 
LETTER 
GRADE 

 
RMK 

1 Adeniji Eunice kemi 03/01/AV/01/053 19 27 46   
2 Adeoye Victor A. 03/01/AV/03/041 19 33 52   
3 Adesanya S. Adekunle 03/01/AV/01/010 19 27 46   
4 Adesuji Modupe Om oboja 03/01/AV/01/054 19 27 46   



10 

 

5 Adeyemi Ademola 03/01/AV/01/055 21 36 57   
6 Afolabi Motunrayo S. 03/01/AV/01/056 22 33 55   
7 Agbebaku Evelyn 03/01/AV/03/002 21 36 57   
8 Agoro Fadilat T. 03/01/AV/03/042 21 33 54   
9 Agunbiade Bukola 03/01/AV/01/140 21 29 50   
10 Ajayi Emmanuel O. 03/01/AV/01/011 19 27 46   

The Problem: 
 
 
 

The above result was submitted by a lecturer.  The examination officer is faced with the 
problem of  providing the  letter  grades  and  thereby seeks  an  easy way this  can  be 
achieved to meet the time line and at the same time minimize error. 

 

 

Question:      What would the examination officer do to achieve this, using excel. 
 
Answer:        To solve this problem, the examination officer has to use the ‘IF Formula’, 

if when defined will eliminate errors in the conversion of scores to letter 
grades and at the same time be fast enough to achieve the desired result. 

 
Procedure: 

 

 

1. Enter the data into excel worksheet and it will appear thus: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. Place your cursor on G2 and type the following formula 
 

 

=IF(F2>69,"A",IF(F2>59,"B",IF(F2>49,"C",IF(F2>44,"D",IF(F2>39," 
E","F"))))) 

 
3. Press the enter key.  The letter grade will appear thus: 
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4. Copy the result in G2 into other cells. The result would be: 
 

 

 
 
 
 

Self Assessment Exercises 
 

 

Practice all that you have read so far with solving business problems with Microsoft 
excel.  Share your experience with your co-students. 

 
4.0      Conclusion 

 

 

There are a lot of ways excel can be used to solve business problems.       But first and 
foremost,  you  must identify the prevailing problem and  know the possible ways of 
solving that problem and then approach the possible solution.    Where you do not know 
the right formula to use, go to the Help function of excel and study the recommended 
ways each formula can be applied. You should always use the help function. 

 
5.0      Summary 

 

 

For excel to effectively help in solving business problems, the user must be able to 
identify the problem areas and the possible solutions to the problem.    After which the 
appropriate section of excel is applied.   There  is no limitation on the type of business 
excel can be used.   Excel if properly applied can be useful in all kinds of business – 
manufacturing or servicing. 
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6.0 Tutor Marked Assignment (TMA) 
 

 

Identify a problem in a particular organisation and use Microsoft Office Excel to solve 
the problem. Explain how you where able to achieve this. 
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1.0      Introduction 
 
Most people usually run into problem with dealing with large data.    At a point it may 
become cumbersome managing data to derive desirable results.  At this point in time it 
becomes necessary to look for alternative ways stress can be reduced in achieving the 
desired goal. 

 

 

2.0      Objectives 
 
At the end of this unit, you will be able to manage large data 

 

 

3.0      Main Content 
 
3.1      Freezing Panes 

 
Freezing panes means making some rows and columns visible while you scroll across the 
work sheet.  Large worksheets usually go beyond the window view at a time.   In this 
instance the part that is required to supply leading information may be kept in view while 
other rows or columns scroll. 

 

 

 
 
 
 

In this excel sheet, the number of students go beyond 14.  To see the other names would 
require scrolling the rows.   But once the rows are scrolled, row 9 would no longer be 
visible because it would scroll up to give space to view the underneath names.  But, the 
information in row 9 is guide to what data  should be entered in each cell of the data. 
Therefore you may want to leave row 9 and column A on view while others scroll.  To 
achieve this, the following steps should be adopted. 
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Procedure: 
 

 

1. Place your cursor on B10 
2. On the view menu, click on Freeze Panes and you will have: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Click on freeze panes 
 
Once this is done, as you scroll, column A and row 9 will be on view.  Originally, the 
data that were on view were S/N 1 – 14.  With freezing of panes, as you scroll you will 
see more data but column A and row 9 constant.  The table below shows the data after 
freezing and scrolling.  You will observe that the new data on the screen view shows S/N 
15 – 28 but with the headings still on view. 
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You could also freeze only row or column instead of freezing both.   It all depends on 
what you need at a time. 

 
3.2      Splitting Window 

 
Another way to manage large data is to split window.     This is very helpful when you 
want to compare values.   Let us consider the academic result of a set of students for 
academic year 2005 and 2006. The data may be entered thus: 

 

 

 
 
To be able to scroll and compare, go to view menu, place your cursor in between the two 
sets of data or any other point as desired.  The placement of the cursor would determine 
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whether the sheet will split horizontally, vertically or both then go to ‘window group’ in 
the view menu and click on ‘split’.  The resulting effect would be: 

 

 
 
This view presents two windows. You can scroll on both. 

 
Thirdly, large data could be managed by hiding the unwanted data at a time.  Supposing 
in the above data, you are only interested in printing the Matric. Number and the Grade 
Point (Letter Grade), but still want to retain the data in the database.  You could take the 
following steps: 

 

 

Step 1:          Highlight the unwanted row, right click, and select ‘Hide’.  Repeat this for 
all unwanted rows and columns.  At the end only the desired columns or 
rows would be left. See the example below: 
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From the above, only columns A, C and G are on view, the other columns in 
between are hidden. To unhide, highlight the columns, right click and select 
‘Unhide’. 

 

 

Self Assessment Exercise 
 

 

Practice working on an excel worksheet with the above examples. Share your experience 
with your colleagues and facilitator. 

 
4.0      Conclusion 

 

 

In  conclusion  always  identify  the  area  of  problem encountered  in  managing  large 
worksheet. This would help you sort out the right solution to the problem using excel. 

 
5.0      Summary 

 

 

There are three basic ways of managing large worksheets.     It could be done through 
freezing of panes, splitting of window and hiding of rows and columns.  The prevailing 
problem would determine the type that may be applied at a time. 

 
 
 

6.0      Tutor Marked Assignment (TMA) 
 

 

Present data involving large worksheet and explain how you where able to manage the 
data. 
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1.0      Introduction 
 
In the previous units, chart was discussed as an illustration device which enhances 
business documentation.  This unit shall be more elaborate on how charts are used in 
presenting data, not just for illustration only.  Data well presented in charts are easier to 
understand than those presented in elaborate texts and figures.  Some people do not have 
the patience to read and deduce facts, thereby may run into wrong conclusion or ignoring 
the data. This is why in business, presentation of data in charts is encouraged. 

 
2.0      Objectives 

 

 

At the end of this unit, you should be able to present data in charts for maximum 
interpretation. 

 
3.0      Main Content 

 
Before we go on  problem solving, let us have a review on creating charts in excel. 

 

 

Creating Charts in Excel 
 

 

Step 1:     Enter the data for the chart in excel worksheet.  The type of chart to be used 
would determine how the data would be entered into the worksheet.     This 
would be discussed later. 

 
Step 2:     Select the cells that contain the data for the chart. 

 
Step 3: On the Insert tab, in the Charts group, click the chart type as desired. 

Step 4: Follow the given instruction to complete the chart. 

To create charts in a way that will make them  meaningful to your audience, you need to 
decide what exactly you want the audience to understand and the type of audience that is 
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target because some charts are easier to understand than others.  Knowing what you want 
will help you to select from the wide range of charts. 

 

 

Things to remember in the use of chart types are the types of charts and the arrangement 
of figures. The type of charts excel provided are: 

 
  Column charts 
  Line charts 
  Pie charts 
  Bar charts 
  Area charts 
  XY (Scatter) charts 
  Stock charts 
  Surface charts 
  Doughnut charts 
  Bubble charts 
  Radar charts 

 
Arrangement of Values in Charts 

 
The type of chart to be used determines the way the values would be entered into the 
worksheet.  Let us briefly look at what should be noted when entering values into 
worksheet for a chart 

 

 

Column Charts – The categories are entered in the horizontal axis and the values are 
entered in the vertical axis. 

 
Line Charts – The categories are distributed evenly along horizontal axis, while the 
values are distributed evenly along the vertical axis. 

 
Pie Charts – shows size of items in one data series, proportional to the sum of the items. 
Data points are displayed as percentage of the whole pie.  Therefore in a pie chart data 
are arranged in one column or row only. 

 

 

Bar Charts – Illustrate comparison among individual items.  Data are arranged in rows 
and columns. 

 
Area Charts – Data are arranged in rows and column of the worksheet.  For example, 
data that represent profit over time can be plotted in an area chart. 

 
XY (Scatter) Charts – Data is arranged in rows and columns.  Scatter charts show the 
relationships among the numeric values in several data series, or plots two groups of 
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numbers as one series of XY coordinates.  In arranging data on a worksheet for a scatter 
chart, place the X value in one row or column, and then enter the corresponding Y value 
in the adjacent rows or columns e.g. 

 

 
 

Days 
 

Weather Forecast 
Predicted Weather 
Forecast 

Monday 32oC 35oC 

Tuesday 36oC 38oC 
Wednesday 24oC 42oC 
Thursday 30oC 34oC 

 
 
 
 

X values Y values 
 

 

Stock  Charts  –  Data  are  arranged  in  columns  and  rows  in  a  specific  order  on  a 
worksheet.  E.g. to create a simple high-low-close stock chart, you should arrange your 
data High, Low, and Close entered as Column Headings, see below: 

 

Date High Low Close 
2/09/09 58 53 55.5 
7/09/09 57 56 56.5 
11/09/09 52 50 51 

 

 

The sub-types of stock charts are: 
 

  High-Low-Close 
  Open-High-Low-Close 
  Volume-High-Low-Close 
  Volume-Open-High-Low-Close 

 
Surface Charts – These charts are useful when you want to find optimum combinations 
between two sets of data.  As in topographic map, colours and patterns indicate areas that 
are in the same range of values.  Data for surface charts is arranged in columns and rows 
on a worksheet.   You can use surface chart when both categories and data  series are 
numeric values. 

 

 

Doughnut Charts – Data are arranged in rows and columns only.     A doughnut chart 
shows the relationship of parts to a whole, it can contain more than one data series. 
Doughnut charts are not easy to read. 
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Bubble Charts – Data are arranged in columns on a worksheet.  The X values are listed 
in the first column and corresponding Y values and bubble size values are listed in the 
adjacent columns e.g. 

 

 

No of Products Sales (N) Market Share %
15 21,500 3 
25 66,200 10 
20 23,000 5 

 

Radar Charts – Data are arranged in columns or rows on a worksheet. Radar  charts 
compare the aggregate values of number of data series. 

 
You can equally create charts in other Microsoft office environment, such as Office 
Power Point 2007 and Office Word 2007.  The process of creation is the same as it is in 
excel.  You can equally copy charts from excel to PowerPoint 2007 and Word 2007. 

 
Modifying Charts 

 
You can modify charts after they have been created. To modify charts, you can: 

 

 

  Change the display of chart axes 
  Add titles and data labels to a chart 
  Add legend or data table 

 
To make your chart eye-catching, you can format your chart to: 

 

 

  Fill  chart  elements. This  will  enable  you  use  colour, textures,  pictures and 
gradient fills 

  Change the outline of chart elements 
  Add special effects to chart elements 
  Format text and numbers 

 
For help, visit the ‘Help Function’ in 2007 Microsoft Excel. 

 

 

Now let us see how we can present some data with the use of charts. 

Example 1 

Present the following data with an appropriate chart. 
 

 
Enrolment in XYZ Primary School 

2005  2006  2007  2008 
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Boys 234 244 342 234 
Girls 231 240 321 231

 

Column or bar charts will be appropriate for this data.  But for the purpose of this study, 
we shall use the column chart. To do this, follow the following procedure: 

 
1. Enter the data into a worksheet 

 

 

 
 

2. Select the cells that contain the data 
 

 

 
 

3. On the Insert tab, in the charts group, click the column chart type and select as 
desired 

 

 

 
 

4. A click on selected column chart will appear thus: 
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5. Click outside the chart and re-click on it, left click without releasing your hand 

and move the chart to desired position. 
 
6. To add title, click on the chart, and select layout menu 

 

 

 
 

 

7. Click on chart title, and select as desired 
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8. Type in the title of the chart in the box “Chart Title”. 
 

 

9. Click outside the chart, your chart is ready. 
 

 

 
 

 

10. You may want to remove the border.   To remove the border, right click on the 
chart and  from the drop down menu select “format Chart Area”, after selection 
you will have: 
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11. Select ‘Border Color’, and click on ‘no line’, then close. The resulting effect 
would be: 

 

 
 
 
 

12. You can remove the gridlines.  To remove the gridlines, select click on the chart 
and select ‘layout menu’, then click on gridlines and select as desired.    The 
resulting effect would appear thus: 
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You can get more effect as desired. 
 

 

Self Assessment Exercise 
 
Get as many data as you can and present them in charts.   You may work in group, or 
share your experience with your facilitator or colleagues at the completion of the task. 

 
4.0      Conclusion 

 

 

There are various types of charts which can be used to present different types of data. 
The kind of data to be presented would determine the type of chart that may be use.  To 
have  a  desirable  result  chart  data  should  be  entered  appropriately  into  the  excel 
worksheet. 

 
5.0      Summary 

 

 

There are eleven types of charts in excel.  These include column charts, line charts, pie 
charts, bar charts, area charts, XY (scatter) charts, stock charts, surface charts, doughnut 
charts, bubble charts and radar charts.  The type of data to be presented would determine 
the type of chart that should be used at a time. 

 
6.0      Tutor Marked Assignment (TMA) 

 

 

Collect data from any form of business and present the data in: 
 

a.  Pie chart 
b.  Bar chart 
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c.  Bubble chart 
d. XY (Scatter) chart 
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1.0 Introduction 
 

 

Graphics are essentials in enriching business documents.  There are major graphics that 
require  special  training,  which  is  usually  categorised  under  desktop  publishing. 
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However, in the day-to-day business, one may not require major training.  What are these 
graphics?  Computer graphics refer to any pictorial representation that can be produced 
by computer, either on the display, printer, plotter, or other output devices (Allen and 
Klooster, 1990). Graphics could be charts, diagrams or pictures. 

 
2.0      Objectives 

 

 

At the end of this unit, you should be able to: 
 

 

  Give examples of computer graphics 
  Describe the use of paint programs 
  Solve business problems with simple computer aided graphic designs 

 
 
 
 
 
 
 
3.0      Main Content 

 

 

There are different types of graphic software, some require special skills and others may 
easily be integrated into documents. The following are examples of graphic software: 

 
  Paint Programs – This allows the user to integrate arts into a document. 
  CAD programmes – This is used for computer-aided drafting and used to assist 

designers of products in drawing plan. CAD could be contrasted to paint. 
  Graphing programs – these include pie, charts, bar graphs etc. 

 
For the business of this course, the paint programme shall be discussed in details.  But 
before we go on to discuss paint, it is important to know that computer graphics are used 
in every kind of business e.g. education, media, manufacturing companies, health etc. 

 

 

Paint 
 
Paint forms a good tool when you want to add special effect to your document e.g. 
shapes, this can be duplicated, flip, rotate, tilt the image and as well perform other desired 
operations. 

 
To access paint, do the following 

 
Click start 

 

 

All programmes 
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Accessories 
 

 

Paint 
 
The arrows indicate the steps. A click on paint would produce the following: 

 

 

 
 
 
 

Working under paint environment is very easy.  All you need to understand know is the 
functions of each tool.  To know what each tool does, place your cursor on a tool, do not 
click,  and it would prompt the function e.g. 

 

 

 
 
This means the “A” sign is a “text” tool.  A click on the text tool would give you a ‘+’ 
sign.  Draw a rectangle with the sign in the free space and type what ever you desire to 
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type. As soon as the rectangle shape is drawn a text menu bar comes up. See the 
example below: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
While within the text box, you can format your text as desired using the text tools.  Now 
let us discuss the function of the other tools: 

 
 

Free – Form Select 
 

Eraser/Colour Eraser 
 

 
Pick Colour 

 
Pencil 

Airbrush 

Line 

 
Rectangle 

 
 

Ellipse 
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Select 
 

Fill with colour 

Magnifier 

Brush 

 

Text 

Curve 

Polygon 

Rounded Rectangle 
 
 

The tools you will often require to do your work include select, eraser, text, line, pencil 
and pick colour or fill with colour.  The select tool will enable you to move text or object 
from one position to another.  To do this, click on select tool and draw a rectangle around 
the text or object, click and move to desired position.  For any of the tools you want to 
use, click on it and apply. 

 
Self Assessment Exercises 

 

 

Perform the following task with paint software: 

a.  Type the words “I love paint software”. 

b.  Draw this as it is 
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c.  Draw the following. You may use different colours. 
 

 

 
 
Share your experience with your colleagues. 

 
4.0      Conclusion 

 

 

The use of paint software helps to improve the effect on our documents. You can copy or 
cut text or object from paint environment to other environments such as word and excel. 
Other graphics software include CorelDraw and Photoshops. 

 
5.0      Summary 

 

 

Graphics help to enhance our business documents.  There are different types of graphic 
software, but the one that can easily be learned is the paint software.  Others may require 
more time to train. 

 
6.0      Tutor Marked Assignment (TMA) 

 
With reference to a particular business problem, present a typed work in which you 
combine Microsoft word and Paint. Explain how you achieved your task. 
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1.0      Introduction 
 
A database is a collection of organised data with relationship in their elements.  This can 
be achieved by using software usually referred to as database management system 
(DBMS).  Database helps to maintain all relevant data in such a way that it will be useful 
to its owner for record keeping and decision making.    There are  commercial database 
management soft wares, but apart from the commercially produced database management 
software, an organisation can have its own customised database software with the help of 
programmers to meet with the day-to-day running of the organisation.  With the use of 
commercial database software, you will be able to enter data, manipulate data, and report 
information from the data without programming. These functions can be categorised as: 

 
  Creating the structure of database 
  Adding data to the database 
  Editing data already in the database 
  Retrieving data 
  Designing reports 
  Modifying the structure of the data base 

 
The type of computer and the brand of software used would determine how these 
functions are accessed by commands, by menu choices selected with the keyboard or by 
making selection with a mouse. 

 

 

The database software that shall be used for analysis in this unit is Microsoft Office 
Access 2007. 

 
2.0      Objectives 

 

 

At the end of this unit, you should be able to: 
 

 

   Identify a database 
   Solve business problems with Microsoft Office Access 

 
3.0      Main Content 
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Database is a collection of related information on a particular subject or purpose.  This 
may involve tracking customers orders.  Information is usually not from one source.  A 
database is formed when a collection of information is organised for quick and easy 
retrieval of needed information.   Database started in paper-based,  examples of paper- 
based database are telephone directories and dictionaries.   A database file divides data 
into separate storage containers called tables.  You can view, add and update table data 
through online forms. 

 
This unit will be devoted more to solving business problems with Access.  The basics of 
Access have been discussed in BED 211 – Microsoft Office.  You should make reference 
to BED 211, and never forget to use the help function (just press F1 key) any time you 
need more assistance. But for the purpose of reminder the following table is presented. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Table 1: General Preview 
Objects Functions 
Table To store data. Create  a table for

each information that you track. 
Query To find and retrieve data.  Query can

also be used for  updating and
deleting multiple records at the same
time. 

Form A form helps you to view, enter and
change data directly in a table. 

Report Report helps to analyse your data 
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 and present it in the format for
printing. 

Data Access Page This helps to make data available on
the internet fro interactive reporting. 

Columns Columns in a table are called fields 
Rows Rows in a table are called records 
Table Datasheet View This enables you to add, edit, view

and work with data in a table. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Table 2: Working with formulas 
 

Function 
 

Description 
Use with the data 
type(s) 

 
 
 

Average 

Calculates the av erage val ue for 
a column. The col umn must 
contai n numeric, currency, or 
date/ti me data. T he function 
ignores null values. 

 
Number, Currency, 
Date/Ti me 
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Maximum 

Returns the item wi th the 
highest val ue. For text data, t 
he 
highest val ue is the last al phabetic 
value  —  Access  i gnores  case.

 
Number, Currency, 
Date/Ti me 

 
 
 

Minimum 

Returns the item wi th the lowest 
value. For te xt data, the lowest 
value is the fi rst alphabeti c value 
— Access i gnores case. The 
function ignores null values. 

 
Number, Currency, 
Date/Ti me 

 

Standard 
Deviation 

Meas ures how widely values are 
dispersed from an average val ue 
(a mea n). 

Number, Currency 

 
Sum 

Adds t he items i n a column. 
W orks only on numeri c and 
currency data. 

Number, Currency 

 
 
 
 
Variance 

Meas ures the stati stical 
variance of al l values in the 
column. You can use this functi 
on 
only on numeric and currency 
data. If t he table contains less than 
two rows, Access r eturns a null 

 
 
 

Number, Currency 

Source: Microsoft Offi ce Access 2007 
 
 
 

For the purpose of solving problems in business, let us look at the following: 
 

 

Working with Query 
 

 

Before you start have a table. To build a query, do the following as suggested by 
Microsoft Office Access 2007. 

 
1. On the Create tab, in the Other group, click Query Wizard. 

 

 

2. In the New Query dialog box, click Simple Query Wizard, and then click OK. 
 

 

3. Under Tables/Queries, click the table that has the data that you want to use. In this 
case, click Table: Customers. Note that a query can also use another query as a 
record source. 
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4. Under Availabl e Fields, double-click the Contact, Address, Phone, and City 
fields. This adds them to the Selected Fields list. When you have added all four 
fields, click Next. 

 
5. Name the query London Contacts, and then click Finish. 

Access displays all of the contact records in Datasheet view. The results show all of 
the records, but show only the four fields that you specified in the query wizard 

 
6. Close the query, and note that your query is automatically saved. 

 
 
 

Calculating Grand Totals Using Query 
 

 

In business transactions, there is often the need to calculate figures, which are used for 
decision making. Here are examples: 

 
The Order Table 

Order 
ID 

Order 
Date 

Ship 
Date 

Ship 
City 

Shipping Fee (N)

1 
2 
3 
4 
5 

11/8/2007 8/12/2007 Benin 1,000.00
2,500.00
2,500.00

500.00
800.00

11/8/2007 8/12/2007 Kano 

8/15/2007 8/18/2007 Abuja 

8/20/2007 8/21/2007 Lagos 

8/20/2007 8/21/2007 Ibadan 
 
 
 
 
 
 
 
 
 
 
 
 

Order Details Table 

Detail 
ID 

Order 
ID 

 

Produc t Name 
Produc t

ID 
Unit Price

(N) 
Quantit 

y 
Discount 

1 
2 

 
 

3 
4 

1 Deep Freezer 12 11,800.95 4 0.05 
0 

 
 

0.03 
0.04 

1 Desktop 
Computer 

1 70,000.25 3 

2 Horse Fan 3 15,000.75 9 

2 Giant Size 5 62,875.00 12 
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Order Details Table 

Detail 
ID 

Order 
ID 

 

Produc t Name 
Produc t

ID 
Unit Price

(N) 
Quantit 

y 
Discount 

 
 

5 
 
 

6 
7 

 Generator    
 

0.06 
 
 

0.09 
0.08 

2 Laptops (Acer) 
8" 

8 68,699.00 11 

3 Microwave oven 9 12,375.00 4 

4 Typist Chair 10 868.00 8 
 

 
 

From the above tables, calculate: 
a. Simple grand total 
b. Calculate grand total that exclude some records 

 
To achieve this follow the following procedure as stated in Microsoft Office Access 
2007: 

 
a. To calculate simple grand total, do this: 

 

 

i. On the Create tab, in the Other group, click Query Design. 
 
 
 
 
 
 
 
 
 
 

Then: 
 
 
 
 
 
 
 

ii. In the Show Table dialog box, 
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double-click the table that you want to use in your query, and then click Close. 
 

 

 
 
 
 

If you use the sample data, double-click the Orders table. 
The table appears in a window in the upper section of the query designer. 

 
iii. Double-click the field that you want to sum. Make sure that the field is set to either 

the Number or Currency data type. If you try to sum values in non-numeric fields, 
such as a Text field, Access displays the Data type mismatch in criteria expression 
error message when you try to run the query. 

 

 

If you use the sample data, double-click the Shipping Fee column. 
NOTE    You can add additional numeric fields to the grid if you want to calculate 
grand totals for those fields. A totals query can calculate grand totals for more than 
one column. 

 
iv. On the Design tab, in the Show/Hi de group, click Totals.  

The Total row appears in the design grid and Group By appears in the cell in the 
Shipping Fee column. 
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v. Change the value in the cell in the Total row to Sum. 
 

 

vi. Click Run  to run the query and display the results in Datasheet view. 
 

 

TIP  Note that Access appends "SumOf" to the beginning of the name of the field that 
you sum. To change the column heading to something more meaningful, such as Total 
Shipping, switch back to Design view, and click in the Field row of the Shipping Fee 
column in the design grid. Place the cursor next to Shipping Fee and type the words 
Total Shipping, followed by a colon, like so: Total Shipping: Shipping Fee. 

 
vii. Optionally, save the query and close it. Then the following appears: 

 

 

 
 
 
 

b. To calculate a grand total that excludes some records. Do the following: 
 

1. On the Create tab, in the Other group, click Query Design. 
 

 

2. In the Show Table dialog box, double-click the Order table and Order Details 
table, and then click Close to close the dialog box. Then this appears: 
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3. Add the Order Date field from the Orders table to the first column in the query 
design grid. 

 
4. In the Criteria row of the first column, type Date() -1. That expression excludes 

the current day's records from the calculated total. 
 

 

5. Next, create the column that calculates the sales amount for each transaction. Type 
the following expression in the Field row of the second column in the grid: 

 

 

Total Sales Value: (1-[Order Details].[Discount]/100)*([Or der Details].[Unit 
Price]*[Or der Details].[Quantity]) 
Make sure your expression references fields set to the Number or Currency data 
types. If your expression refers to fields set to other data types, Access displays the 
message Data type mismatch in criteria expression when you try to run the 
query. 

 
6. On the Design tab, in the Show/Hi de group, click Totals. 

The Total row appears in the design grid and Group By appears in the first and 
second columns. 

 
7. In the second column, change the value in the cell of the Total row to Sum. The 

Sum function adds the individual sales figures. 
 

 

8. Click Run  to run the query and display the results in Datasheet view. 
9. Save the query as Daily Sales. 

NOTE The next time that you open the query in Design view, you might notice 
a slight change in the values specified in the Field and Total rows of the Total 
Sales Value column. The expression appears enclosed inside the Sum function, 
and the Total row displays Expression instead of Sum. 
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For example, if you use the sample data and create the query (as shown in the 
previous steps), you see: 

 

 

Total Sales Value: Sum((1-[Order Details]. Discount/100)*([Or der 
Details].Unitprice*[Or der Details]. Quantity)) 

 

 

The use of Microsoft Access is not restricted to buying and selling, it could equally be 
used in educational institutions. Access enhance student database. 

 
 
 

Self Assessment Exercises 
 

Practice the examples given above and share your experience with your colleagues. 
 

 

4.0      Conclusion 
 

 

Database software enhances decision making in business especially in critical times of 
solving problems. But correct data need to be fed into the database so as to be able to get 
accurate information that would be required for decision making. 

 
5.0      Summary 

 
There are different types of database software.  Some are commercially produced while 
some are customised.  To have a customised software requires a programmer who will 
programme what is required in the organisation. 

 
 
 
 
 
 
 
 
 
 
 
 
 

6.0      Tutor Marked Assignment (TMA) 
 

 

Students' Data 
 

 

S/N 

 

 

Surname 
First 
Name 

 

School 
 

State of Origin 
1 Adegoke Judith Education Ondo 

 

 

2 

 

 

Okonofua 

 

 

Otihbor 
Arts and Social 
Sciences 

 

Edo 
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3 Okoro John Law Aba 
4 Adeboye Caroline Education Oyo 
5 Ujagbe Mary Law Edo 
6 Abanikannda Adegoke Business Lagos 
7 Amekhiena Maria Business Edo 
8 Oyakhilome Ebi Education Ondo 

 

 

9 

 

 

Okoruwa 

 

 

Ani 
Arts and Social
Sciences 

 

Delta 
 

 

10 

 

 

Abraihim 

 

 

Adako 
Arts and Social 
Sciences 

 

Kano 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Examination Scores 
for 2007 

 

 
 
S/N 

 
 
Surname 

 
First 
Name 

 
 
School 

 
Programme 

Lev 
el 

 
Course 

Exam 
Scores 
(100%)

 

 
1 

 
Adegoke 

 
Judith 

 
Education 

Business
Education 100 BED 112

  
40 

 
 

2 

 
 
Okonofua 

 
 
Otihbor 

Arts and 
Social 
Sciences 

 
Theology 

 
300

 
TH 321 

  
 
50 

3 Okoro John Law Criminal Law 200 LAW  55 
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      223  
 

4 
 
Adeboye 

 
Caroline 

 
Education 

Primary 
Education 100 PRI 134 66 

 
5 

 
Ujagbe 

 
Mary 

 
Law Civil Law 200

LAW

222 65 
 

6 
 
Abanikannda 

 
Adegoke 

 
Business 

Entrepreneu 
rship 300

BHM 
342 56 

 
7 

 
Amekhiena 

 
Maria 

 
Business 

Banking and
Finance 300

BHM
223 67 

 
8 

 
Oyakhilome 

 
Ebi 

 
Education 

Business
Education 200

EDU
223 55 

 
 

9 

 
 
Okoruwa 

 
 
Ani 

Arts and
Social 
Sciences 

 
French 

 
100

 
FRE 111 

 
68 

 
 

10 

 
 
Abraihim 

 
 
Adako 

Arts and
Social 
Sciences 

 
English 

 
200

 
ENG 
221 

 
67 

 
 
 
 

i.  Prepare a database for the above data in the tables 
ii.  Show the results of serial numbers 2,3,5,6, and 10 with other details of the students 
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1.0 Introduction 



142  

 

Microsoft Office Outlook is very useful in office management.  It has four major areas 
where its value is very essential in business.  These include mail, calendar, contacts and 
tasks.  Though the basics of this software has been taught in BED 211 – Microsoft Office, 
a review of it shall be made in this unit, while the main focus would be  on solving 
business problems using Microsoft Office Outlook 2007. 

 

 

2.0      Objectives 
 

 

At the end of this unit, you should be able to: 
 

  Organise meetings effectively using Microsoft Office Outlook 
  Monitor tasks adequately using Microsoft Office Outlook 

 
3.0      Main Content 

 
Microsoft Office Outlook 2007 as earlier mentioned has four major features – calendar, 
contacts, tasks and mail. We shall discuss these briefly and apply them to some problems 
that may often arise in business. 

 
With calendar, you can: 

 

 

  Create appointments and events – This can be achieved just  the same way you 
write in a notebook, click anytime slot in the outlook calendar and begin typing. 
The current time is highlighted in colour.  You could have message reminder of 
meetings, appointments, and events.   You can easily colour items for quick 
identification. 

  View group schedules – With calendar you can show the schedules of a group of 
people or resources simultaneously.  For instance you can view the schedules of 
all the persons in your department or other units. 

  Organi se meetings – to organise a meeting, select calendar and create a meeting 
request. 

  View  Calendars  Side  by Side  – Different  Calendars created by  you can  be 
viewed side-by-side and at the same time calendars shared by other outlook users. 
Appointments can also be copied and moved between the displayed calendars. 

  View Calendars on top of each other in overlay view – This display multiple 
calendars that you have created as well as calendar shared by other outlook users. 

  Manage another user’s calendar – You can manage another person’s calendar 
with the use of Delegate Access feature.  For example an administrative assistant 
can manage the calendar of a manager or his boss. 
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With Contacts you can create contacts from within contacts, from an e-mail message that 
you receive and from electronic Business Cards that you receive. 

 
Tasks – To create a task the following are applicable: 

 
  To create and track assigned tasks – after you have completed a task and assign to 

some one, you may still need to manage it.  For example, you might need status 
report and updates of the task in progress. 

 
To assign a task, first create the task, and send it as task request to someone.  The 
person can decline the  task, accept the task or assign the task to someone else. 
The task is returned to you if it is declined, but even when the declined task is 
returned to you, it is still owned by the recipient until you reclaim ownership by 
returning the task to your own task list. 

 

 

But if you assign a task to more than one person at a time, you would not be able 
to keep an update copy of that task in your task list. 

 
  To assign a task to someone the following steps are suggested by Microsoft Office 

2007: 
 

1. To assign new task do the following: 

On the file menu 

 

 

Point to New 
 
 
 

Click Task Request, then the following will appear 
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2. To assign existing task, do the following: 
Go to the task list 

 
 
 
 

Open the desired task 
 
 
 

 
On the Task tab in the manage Task group, click Assign Task 

 

 

  In the box ‘To’, enter the name or e-mail address of the person to whom you want 
to assign the task. 

 
  Type the name of the task in the subject box.  For an existing task, the subject box 

is already filled in except you want to change. 
 

 

  Select the due date and status options as desired. 
 

 

  Select or clear the keep an updated copy of this task on my task list check box and 
the send me a status report when this task is complete check box. 

 

 

  To repeat the task, on the Task tab in the options group, click Recurrence, select 
desired options and click ok. 

 

 

  In the body of the recurring task, type any information you want to include in the 
task. 

 

 

  Click send. 
 

 

To forward a task to someone else to track, do the following: 
 

1. Open the task you want to send 
2. On the Task tab, in the manage Task group, click forward 
3. Enter recipient names or e-mail addresses in the, “to” and “cc”, boxes 
4. Type the message at the body of the task 
5. Click send 

 

 

To reclai m a rejected test manage ment, do the following: 
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1. Open the e-mail message that contains the task request, which you will find in 
Sent item Folder. 

2. On the Task tab, in the manage Task group, click Return to Task list.  Task can 
also be reclaimed from the declined task message by clicking Return to Task List. 

 
To track tasks that you have assigned, do the following: 

 

 

Automatically copies of the tasks assigned are kept and you receive automatic status 
reports. 

 
1. On the tools menu, click options 
2. Click Task Options 
3. Select the keep updated copies of assigned tasks on my task list check box 
4. Select the send status reports when assigned tasks are completed check box 

 

 

To view Tasks Assigned to others, do the following: 
 

1. Click Tasks 
2. On the View Menu, point to Current View and then click Assignment 

To view the list of people who received updated copies of an assigned task, do the 
following: 

 
1. Open the assigned task you want to view the list 
2. From the Details tab, view the names in the Update list box 

 

 

To Accept or decline a task assignment, do the following: 
 

1. Open the task or task request 
2. On the Task tab, in the manage Task group, click Accept or Decline 
3. Then: 

a.  Click edit the response before sending, type your comment in the message 
and click send. 

b. Click send the response now 
 

 

To send a status report or a comment about a task assign ment, do the following: 
 

1. Open the task for which you want to send a status report or comment 
2. On the Task Tab, in the Manage Task group, click either Send Status Report, 

Reply or Reply to All 
3. Enter recipient names or e-mail addresses in the To and cc boxes 
4. Type any information that you want to include at the status report in the body of 

the message 
5. Click send 
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To create an e-mail message, do the following: 
 

 

This is the most frequent task that is performed in Microsoft Office Outlook.  Follow the 
process of creating the usual e-mail.  Click on the e-mail option and follow the display on 
the menu. 

 

 

To set the delivery Options: 
 

Setting message in the order of importance enables the recipients to sort their message 

important.   To do this, go to the message Tab in the option group, click          High 

Importance or  Low Importance. 
 

 

To set message expiring date, do the following: 
 

1. On the option tab, in the more options group, click the message Options group, 
click the message options Dialog Box Launcher 

2. In the Message Options dialog box, under Delivery Options, select the Expires 
after checkbox and click a date or time. 

In Delay Sending a Message, do the following: 
 

1. On the options tab, in the More Options group, click delivery 
2. Click delivery date and time that you desire 

 
With this review of our Microsoft Office Outlook, let us look at the following problems: 

 

 

Proble m A 
 

Company XYZ has it’s headquarters office at Abuja but with branches in the 36 states of 
the country Nigeria.  The company runs a central administration from the headquarters at 
Abuja.  The Head of Administration has new tasks to assign to all heads of units at the 
various branches which must be accomplished within one week of assignment.  He has 
the following information to pass across. 

 

 
 

S/N Head of 
Unit 

 

e-mail Address 
 

Branch Message Start Date
of Task

1 Mr. K.O. 
Akaka oakaka@xyz.com  

 
To send the update of all transactions within 
the last four months to the headquarter on or 
before 7th  October, 2009 

 
 
 
 

1/10/2009 
2 Mr. E. B. 

Adeboye badeboye@xyz.com Ibadan 

3 Mrs. H. E. 
Ikejama eikejama@xyz.com Benin 

4 Ms. K. K. 
Udoh kudoh@xyz.com Warri 
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5 Mr. Ada 
Ada aada@xyz.com Lagos   

6 Mr. J. K. 
Okouwa kokouwa@xyz.com Minna 

7 Mr. J. J. 
Johnson jjohnson@xyz.com Zaira 

 
 
 

From the above information and with the use of Microsoft Office Outlook, 
 

 

a.  Assign task to heads of units 
b. Forward the task to the head of units in the specified branches 
c.  Track the assigned task to head of units 
d.  Send a status report on the assigned task 

 
To achieve these tasks the following procedure would be taken: 

 
 
 

1. Assign task to heads of units 
 

 

To do this, click on file menu, point to the New 
 

 

 
 
 
 

Then click Task Request, and the following will appear: 
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In the box ‘To’, enter the name or e-mail addresses.  In this instance, we shall use head of 
units.  In addition, the name of the task, due date and status options, keep an updated and 
other necessary boxes were filled. See below: 

 

 

 
 

Then click send. 
 
 
 

2.     Forward the task to the head of units in the specified branches 
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To forward the task to the head of units, their e-mail address would be used. 
Every other entry may remain the same.  After entry the necessary data, your box 
will appear thus: 

 

 

 
 
 
 

A click on  ‘forward’ on the Task tab, will give you: 
 

 

 
 
 
 

Enter the recipient names or e-mail addresses in the to and cc boxes and type the message 
at the body of the task, then you will have: 
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Click send 
 
3. Track the assigned task to head of units 

 

 

To track the assigned task, on the tool menu, 
 

 

 
 

Click options, you will have 
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Then click Task options, and you will have: 
 
 
 
 
 
 
 
 
 
 
 
 
Then click OK. 

 
 
 

4. Send a status report on the assigned task 
 

 

To send status report, open the task for which you want to send a status report or 
comment.  In this instance, we will open the task we are using currently, which we 
call ‘Task on Going’. 

 
Then on the task bar, in the manage Task group, click send status Report. 
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Enter recipient names or e-mail addresses in the To and cc boxes and type any 
information that  you  want  to  include at  the  status report in  the  body of  the 
message. 

 

 

Self Assessment Exercises 
 
Practice these steps once more and share your experience with your colleagues. 

 

 

4.0      Conclusion 
 
The use of Microsoft Office Outlook enhances communication within an office.  It could 
be used to replace paper memoranda. 

 
5.0      Summary 

 

 

Microsoft Office Outlook 2007 covers the management of mail, calendars, contacts and 
tasks; which are basic requirements for the smooth running of any type of business.  Go 
through the steps above to ensure adequate usage of Outlook. 

 
6.0      Tutor Marked Assignment (TMA) 

 
With reference to a particular business, identify the problem areas that require the use of 
Microsoft Office Outlook.  Explain how Microsoft Office Outlook can be used to solve 
the problems. 
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15 

2007 Microsoft Office 
 

 

Allen C. and Klooster (1990).  Computers and Information Processing.  U.S.A. South- 
Western Publishing Co. 

 
Bowling Green State University – College of Education and Human Development – 

Busine.  http://www.bgsu.edu/catalog/EDHD/EDHD31.html. Retrieved 13th 
February, 2006 

 
Burke L. and Weill B. (2000). Information Technology for the Health Professions. 

U.S.A. Upper Saddle River, New Jersey. 
 
Debra Cross/Frank Akaiwa karleen  Nordquist/Jessica Evans (2006). Business 

Computing Using Excel and FrontPage. U.S.A., Thomson Course Technology. 
 
Gross D., Akaiwa F., Nordquist K. and Evans J. (2008). Business Computing Using 

Excel and FrontPage. U.S.A. Thomson Course Technology. 
 

 

Peter Norton (1999).  Introduction to Computers (3rd  Edition). Glencoe McGraw – Hill, 
New York, Woodland Hills, California, Peoria, Illinois. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Unit 4 Desktop Tools/Data Communicati on/Creati ng Website 

 
Contents 

 

 

1.0 Introduction 
2.0 Objectives 



152  

3.0      Main Content 
4.0      Conclusion 
5.0      Summary 
6.0      Tutor Marked Assignment (TMA) 
7.0      References/Further Readings 

 
 
 

1.0      Introduction 
 

 

We have  discussed  some  major  software  that  enhance  business  transactions,  such 
software  Microsoft Office Word, Microsoft Office Excel, Microsoft Office Access and 
Microsoft Office Outlook.   In this unit, we shall discuss other features, though not very 
major are essential in electronic office administration.  This includes Desktop tools, Data 
Communication and creating website. 

 
2.0      Objectives 

 

 

At the end of this unit, you should be able to: 
 

  Apply simple desktop tools in solving business problems with ease 
  Choose adequate communication hardware and software to solve diverse business 

problems 
  Direct the basics of web creation 

 
3.0      Main Content 

 
The three main areas of concentration in the desktop tools in this unit shall be ‘the 
Address Book’, ‘Calculator’ and ‘Notepad’. But the address book shall be discussed in 
details.  The address book provides convenient way storing important information about 
people; finding business partners; creating contact; sending and receiving business cards 
electronically.    The calculator is simplified for any user to be able to solve simple 
mathematical challenges and the notepad is designed for easy typing of data.  To launch 
these tools; click start, point to programmes, point to accessories and click on the desired 
tool. 

 

 

Storing Contact 
 
There are different ways of adding contact to address book.  These shall be discussed as 
detailed by the package (See Help Function in Address Book). 
To add names directly from e-mail messages to your Address Book, 
You can set up Outlook Express so that when you reply to a message, the people you 
reply to are automatically added to your Address Book. In addition, any time you send or 
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receive a message in Outlook Express, you can add the recipient's or sender's name to 
your Address Book. 

 

 

To add all replies recipients to your Address Book 
 

1. In Outlook Express, on the Tools menu, click Options. 
2. On the Send tab, click Automatically put people I reply to in my Address Book. 

To add an individual name to your Address Book from Outlook Express 
   In a message you are viewing or replying to, right-click the person's name, and 

then click Add to Address Book. 
   In the message list of your Inbox or other mail folder, right-click a message, and 

then click Add Sender to Address Book. 
 

 

To import an address book from another program 
 
You can import address book contacts from other Windows Address Book files (.wab), as 
well as from Netscape Communicator, Microsoft Exchange Personal Address Book, or 
any text (.csv) file. 

 

 

For Windows Address Book files: 
 

1.     In Address Book, on the File menu, point to Import, and then click Address Book 
(WAB). 

2.     Locate and select the address book you want to import, and then click Open. 
For all other address book formats: 

1.   In the Address Book, on the File menu, point to Import, and then click Other 
Address Books. 

2.   Click the address book or file type you want to import, and then click Import. 
 

If your address book is not listed, you can export it to either a text (.csv) file or an LDIF 
(LDAP Directory Interchange Format) file, and then import it using that file type. 

To add a contact to your Address Book 
 

1.   On the Outlook Express toolbar, click Tools, and then click Address Book. 
2.   In the Address Book, select the folder to which you want to add a contact. 
3.   On the Address Book toolbar, click New, and then click New Contact. 
4. On the Name tab, type at least the first and last name of the contact. This is the 

display name. 
 

A display name is required for each contact. If you enter a first, middle, or last 
name, it will automatically appear in the Display box. You can change the display 
name by typing in a different name or by selecting from the drop-down list. The 
drop-down list will contain variations of the first, middle, and last name, as well as 
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anything you typed in the Nickname box or the Compa ny box on the Business 
tab. 

 
5.      On each of the other tabs, add any information you would like to include. 

 
Notes 

 

 

  Be sure to include an e-mail address for your contact. While your Address Book 
can be used for many purposes, its most immediate benefit is in providing e-mail 
addresses when you are composing mail. 

  If you include a contact's street address on the Home tab or the Business tab, you 
can click View Map located on each of these tabs to display a printable street 
map showing the contact's address. 

 

 

To find people and businesses on the Internet 
 

1. In the Address Book, click Find People on the toolbar. 
2. From the Look in drop-down list, select the directory you want to search. 
3. On the People tab, type the name or e-mail address of the person you want to look 

for, and then click Find Now. 
 

-or- 
 

 

On the Advanced tab, define the search criteria you want by filling in the top three 
boxes, and then click Add. Add all the search criteria you want, and then click Find 
Now. (To remove a search criterion you added, select the item you want to delete from 
the Define Criteria list, and then click Remove. Or, if you want to delete all criteria and 
start over, click Clear All.) 

 
Notes 

 

 

  Your search will be most efficient if you use starts with or is. The options for 
contains,  ends  with,  or  sounds  like  can  make  your  search  take  much  longer, 
possibly so long that the search fails. The more exact your search criteria, the faster 
the result. 

  If your search is too broad, the number of matches might exceed the limits of the 
server, or your directory service settings might not be set up to handle all of the 
returned matches. You can change these directory service settings. 

 

 

To import a business card 
 

1. In the Address Book, on the File menu, point to Import, and then click Business 
Card (vCar d). 
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2. Locate the business card file on your computer or a network drive, select it, and 
then click Open. 

 
Note 

 
  When the business card is added to your Address Book, a dialog box appears 

where you can modify or add to the contact information as necessary. 
  Once the contact's street address is entered on the Business tab, you can click the 

tab's View Map button to display a map pinpointing the address. When you click 
View Maps, Expedia Maps opens in your browser with a printable street map 
showing the contact's address. 

 

 

To change contact information 
 
  In the Address Book list, locate and double-click the name you want, and then 

change the information as needed. Click the tabs to access different information 
sections. 

 
Note 

 

 

  To delete a contact, select the contact name in the Address Book list, and then 
click Delete on the toolbar. If the contact is a member of a group, the name will 
also be removed from the group. 

 
 
 

To create a group of contacts 
 
You can create a single group name (or alias) to use when sending a message to several 
contacts at once. Simply create a group name and add individual contacts to the group. 
Then, just type the group name in the To box when you send e-mail. 

 
1. In the Address Book, select the folder in which you want to create a group. Click 

New on the toolbar, and then click New Group. 
2. The Properties dialog box opens. In the Group Name box, type the name of the 

group. 
3. There are several ways to add people to the group: 

o To add a person from your Address Book list, click Select Members, and then 
click a name from the Address Book list. 

o To add a person directly to the group without adding the name to your Address 
Book, type the person's name and e-mail address in the lower half of the 
Properties dialog box, and then click Add. 

o To add a person to both the group and your Address Book, click New Contact 
and fill in the appropriate information. 
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o To use a directory service, click Select Members, and then click Find. Select a 
directory service from the drop-down list at the end of the text box. 
After finding and selecting an address, it is automatically added to your Address 
Book. 

4.   Repeat for each addition until your group is defined. 
 

Note 
 

  To view a list of your groups separately from the Address Book listings, in the 
Address Book, on the View menu, make sure that Folders and Groups is 
selected. 

  You can create multiple groups, and contacts can belong to more than one group. 
 
 
 
 
 
 

To add a contact to an existing group 
 
1. In the Address Book list, double-click the group you want. The group's Properties 

dialog box opens. 
2. You can add people to the group in several ways —and in some cases you can add 

them to your Address Book as well. 
o To add a person from your Address Book list, click Select Members, and then click a 

name from the Address Book list. Click Select, and then click OK. 
o To use a directory service (use the drop-down list at the end of the text box to see 

directories you have added to Outlook Express), click Select Members, and then 
click Find. Select a directory service to search, enter your search criteria, and 
when you find the person, click Select, and then click OK. 
This person's name and e-mail address is added to your Address Book. 

o To add a person directly to the group without adding the name to your Address 
Book, type the person's name and e-mail address in the boxes provided in the 
lower half of the dialog box, and then click Add. 

o To add a person to both the group and your Address Book, click New Contact, fill 
in the appropriate information, and click OK. 
To create a business card 

 
The easiest way to exchange contact information with people over the Internet is by 
attaching a business card to e-mail messages. A business card is your contact information 
from the Address Book in vCard format. The  vCard format can be used with a wide 
variety of digital devices and operating systems. 

 

 

You must have your contact information in your Address Book before you can create a 
business card. 
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1. In the Address Book, create an entry for yourself, and then select your name from the 
Address Book list. 

2. On the File menu, point to Export, and then click Business Card (vCar d). 
3. Select a location in which to store the file, and then click Save. 

 
Note 

 
     To add your business card to an e-mail message, on the Insert menu, click My 

Business Card. 
 

 

To add a contact's digital ID to your Address Book 
 
To send someone encrypted mail, you must have the recipient's digital ID, and that ID 
must be associated with  the recipient's name in your Address Book. Outlook Express 
automatically adds digital IDs to your Address Book when you receive digitally signed 
mail. If you have turned off this option, you will need to manually add a contact's digital 
ID. 

 
1. Open the digitally signed message. 
2. On the File menu, click Properties. 
3. Click the Security tab, and then click Add digital ID to the address book. 

When a contact has a digital ID, a red ribbon is added to their card in your Address 
Book. 

 

 

To add a digital ID to your Address Book from another source 
 

 

1. In  the  Address Book, create a  new entry for  the contact, or  double-click an 
existing one in the Address Book list. 

2. On the Digital IDs tab, click Import. 
3. Find the digital ID file, and then click Open. 

 
Notes 

 

 

  To automatically add a contact's digital ID to your Address Book, on the Tools 
menu, click Options. Then on the Security tab, click Advanced, and select Add 
senders' certificates to my address book. 

  You can also get someone's digital ID by downloading it from a certification 
authority's Web site. (See the  Microsoft Internet Explorer Digital ID site for links 
to certification authorities.) 

 

 

To organize names in your Address Book 
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When you have a large Address Book, you can organize it in several ways to make it easy 
to retrieve contacts and groups. 

 

 

  To sort contacts by name, e-mail address, or phone number, click the appropriate 
column heading above the name list. 

  To switch columns between ascending and descending sort order, click the column 
heading. 

  To change the order of the columns, point to a column heading (Name, E-mail 
Address, Home Phone, and so on), and then drag the column to the left or right 
until it's located where you want it. 

  To view a list of your mailing groups, on the View menu, select Folders and 
Groups. 

 

 

What are identities? 
 
Creating identities is a way for several people to use Outlook Express and the Address 
Book on the same computer. For example, you and a family member may share a 
computer. If you each create an identity, you would each see your own mail and your 
own contacts when you log on under your identity. Once your identity is created, you can 
organize your contacts the way you want them by creating subfolders. 

 
Usually, you will create identities while you are using Outlook Express (or other 
applications that use identities). You can create identities from your Address Book only 
when you open your Address Book from the Start menu rather than from Outlook 
Express.  To  open  Address  Book  from  the  Start  menu,  click  Start,  point  to  All 
Progra ms, point to Accessories , and then click Address Book. 

 

 

Organi zing contacts and folders 
 
You can keep contacts in your main folder, as well as organize them into subfolders. If 
you have contacts you would like to share with the other people with whom you share 
Outlook Express, you can move contacts into the Shared Contact's folder, where other 
identities can view them when they use the Address Book. Subfolders are always in 
alphabetical order; you cannot reorganize them. 

 
If you cannot see the folders on the left, point to the View menu and select Folders and 
Groups. 

 

 

Deleting contacts from your Address Book 
 
You can easily remove contacts and groups from your Address Book. When you delete a 
contact from a group, the name is removed from the group but the entries for both the 
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group and the individual remain in your Address Book. Likewise, deleting an entire 
group does not remove the entries for the individual members who made up the group. 

 
 
 

To print Address Book information 
 

1. In the Address Book, select the contacts you want to print. 
o To select a block of names, press and hold down the SHIFT key, click the first 

name in the block and then click the last name in the block. 
o To select individual names, press and hold down the CTRL key while you 

click the names. 
2. Click Print on the toolbar. On the Print dialog box, under Print Style, select a 

printing style: 
o To print all Address Book information about the contacts, click Memo. 
o To print business-related information about the contacts, click Business Card. 
o To print a list of phone numbers for the selected contacts, click Phone List. 

 
Note 

 
  You may be able to customize the size and orientation of your printed Address 

Book pages. To view your printer's options, in the Print dialog box, click 
Properties. 

 

 

Finding People using Directory Service 
 
What are directory services? 

 
A directory service  is  a  powerful search  tool  that  you  can  use  to  find  people  and 
businesses around the world. The Address Book supports LDAP (Lightweight Directory 
Access Protocol) for accessing directory services, and it comes with built-in access to 
several popular directory services. You can also add additional directory services from 
your Internet service provider. 

 
Like the Internet search tools, directory services use different methods for collecting data, 
so when you are trying to find people or businesses online, you might try more than one 
service. 

 

 

To add a directory service 
 
To add a directory service to your Address Book, you will need the name of the computer 
server (available from the directory service provider). 

 
1. In either the Address Book or Outlook Express, on the Tools menu, click Accounts. 
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2. In Outlook Express, select the Directory Service tab, click Add, click Directory 
Service, and then follow the instructions in the Internet Connection Wizard. 

 
In  the  Address  Book,  click  Add,  and  follow  the  instructions in  the  Internet 
Connection Wizard 

 

 

To find people and businesses on the Internet 
 
1. In the Address Book, click Find People on the toolbar. 
2. From the Look in drop-down list, select the directory you want to search. 
3. On the People tab, type the name or e-mail address of the person you want to look 

for, and then click Find Now. 
 
-or- 

 

 

On the Advanced tab, define the search criteria you want by filling in the top three 
boxes, and then click Add. Add all the search criteria you want, and then click Find 
Now. (To remove a search criterion you added, select the item you want to delete from 
the Define Criteria list, and then click Remove. Or, if you want to delete all criteria and 
start all over, click Clear All.) 

 
Notes 

 

 

  Your search will be most efficient if you use starts with or is. The options for 
contains,  ends  with,  or  sounds  like  can  make  your  search  take  much  longer, 
possibly so long that the search fails. The more exact your search criteria, the faster 
the result. 

  If your search is too broad, the number of matches might exceed the limits of the 
server, or your directory service settings might not be set up to handle all of the 
returned matches. You can change these directory service settings. 

 

 

To set up a directory service to check for e-mail addresses 
 
When you can't remember someone's complete e-mail address, you can enter a partial 
name and then use the Check Names command on the Tools menu to search for matches. 
Outlook Express first searches your Address Book and if no matches are found, searches 
the directory services you have set up to check e-mail addresses. 

 

 

1. In the Address Book or Outlook Express, on the Tools menu, click Accounts. 
2. If you are in Outlook Express, click the Directory Service tab. 
3. Select a directory service, and then click Properties. 
4.  On the General tab, select the Check names against this server when sending 

mail 
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Using Your Address Book with other Programmes 
 

To export your Address Book contacts to other programs 
 

You can export your Address Book contacts to other Windows Address 
Book (.wab)  files,  as  well as to Microsoft Exchange Personal Address 
Book, or any text (.csv) file. 

 
To export your Address Book files to another Windows Address Book: 

 
1. In Address Book, on the File menu, point to Export, and then click 

Address Book (WAB). 
2. Locate and select the Windows Address Book file you want to export to, 

and then click Open. 
For all other address book formats: 

1. In the Address Book, on the File menu, point to Export, and then click 
Other Address Book. 

2. Click the address book or file type you want to export to, and then click 
Export. 

 

 

To set up a conference call from the Addres s Book 
 

 

If you use Microsoft NetMeeting or other conferencing software, you can 
store  conferencing  account   information   (such   as   e-mail  and   server 
addresses) along with other contact information and then make a 
conferencing call directly from the Address Book. 

 
1. In the Address Book, double-click the contact name. 
2. On the  NetMeet ing tab,  type  the  Conferencing Server  address. (If 

NetMeeting is not installed, this tab is named Conferencing). 
3. Type the Confere ncing Address for the contact. This address must be 

the  one  used  for  conferencing,  which  could  be  different  from  the 
contact's e-mail address. 

4. Click Add to add this information to the contact's properties. 
Now, whenever you want to initiate a conference call, you can click Call 
Now  on  the  NetMeeti ng  (or  Conferencing)  tab  of  the  contact's 
properties. 

 
Note 

 

 

   You can  have  multiple e-mail addresses and  directory servers  listed  for  one 
contact. 
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Communicati on 
 

 

No business can function without communication.  Data communication is achieved by 
using communication hardware, software and transmission carriers.  Computers that are 
connected to communicate with each other are referred to as ‘being network.’ 

 

 

Advantages of Data Communication 
 
A good data communication leads to the following advantages: 

 
  More individuals have access to available hard and software 
  Expensive equipment can be shared 
  Data can be shared among users 
  Many tasks can be completed more conveniently and effectively 

 

 

Disadva ntages of Data Communicati on 
 

 

Apart from the advantages associated with the use of data communication, there are 
equally disadvantages as stated below: 

 
  There would be no work once the mainframe computer goes down 
  High cost for backup systems and maintenance 
  Cost for transmission carriers can be high 
  Needs high trained and experienced personnel 
  Problem of incompatibility among hardware and software that may highly arise 

 

 

Uses of Communicati on Hard and Software 
 

1.  Bulletin  Board  Systems. This  involves  sharing  and  exchanging  ideas  and 
information, which could come in: 

a.  Electronic mail 
b. General messages and announcements 
c.  File library that the user can download 

2. Information Services. The area of information services include: 
a.  Local and national news 
b.  Weather 
c.  Travel 
d.  Recipes 
e.  shopping 

3.  Bibliographic Services. This is connected with  library,  and is as used in the 
library. 
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4. Stock Exchange Services. This includes: 
a.  Comprehensive company  profile as per investors,  earning  forecast, 

price/volume, charts, financial history 
b.  Up-to-date stock prices and quotes 
c.  Individual customer portfolio management 

5. Electronic banking and transfer of funds 
 

 

Creating a Web Site 
 

 

It is advisable to have basic ideas about web site creation.  You are not required to be an 
expert.  With the advent of electronic marketing, you may be required to customise your 
company’s web site. 

 
To develop a web site requires the creation of a team. The team includes: 

 
1. Graphic  designers  –  they  develop  the  visual  appearance and  create  graphic 

images of the site. 
2. Marketing representative –  Sets the  goals for the web side and controls the 

presence of the organisation. 
3. Content developer and editor – prepares and evaluates the content. 
4. Director – This could also be referred to as webmaster.  He co-ordinates teams’ 

activities and at the same time manages web development. 
5. Programmer – Creates HTML documents and develops server processing. 
6. Systems  administrator  –  Conversant  with  web  server  limitations,  manages 

security and access and maintains system hardware. 
 
Developing a website involves the following activities: 

 

 

  Define the goal and purpose of the web site. This will include: 
o Primary intent 
o Short and long-term goals 
o Intended audience 
o Website plan – objectives, requirements and results. 

  Determine and prepare the web site’s content.  After the plan, the next stage is to 
develop the website content. (gather relevant documents), you may re-visit the 
planning team for information. 

  Designing the website. This may include: 
o Working with the organisation objectives 
o Preparing a sitemap 
o Building the site 

  FrontPage is used to build and create a web site 
  In building and creating web site, you need to: 

  Determine the number of page web site 
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  Specify the browser version 
  Specify the page size 

o Text in web page – to determine the type of text a web page should have 
you need to: 
  Determine the format 
  Proofread the content 

o Language  used  –  The  common  language  used  is  Hypertext  Markup 
Language (HTML), which can be viewed with the use of FrontPage. 

 
Self Assessment Exercise 

 

 

With the aid of the above illustrations, organise your Address Book.    Share  your 
experience with your colleagues. 

 
4.0      Conclusion 

 
In conclusion, it should be noted that there is no business that will be able to achieve a 
desired goal in this technological age without effective use of the computer in the 
administration of the business.   A good use of the computer application leads to 
effectiveness and efficiency in business. 

 
 
 
 
 
 

5.0      Summary 
 
In this unit, we have discussed elaborately, the use of Address Book.  But we should not 
forget the use of calculator and Notepad.   The Notepad can be likened to a note pad used 
in long hand. 

 
Microsoft Power Point was not discussed in this course because it has been fully taught in 
BED 211.   But for the  purpose of completeness, PowerPoint is very essential during 
presentation, especially when you want to have a demonstration of your product.  All the 
required effect can always be added for the purpose of illustrations. 

 

 

6.0      Tutor Marked Assignment (TMA) 
 
With reference to a particular organisation, explain how Address Book would help the 
business achieve its goal.  Demonstrate the process. 
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